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About the Tutorial

Windows Server 2012 codenamed Windows Server 8 is the most recent version of the
operating system from Microsoft regarding server management, but not the last one which
is Windows Server 2016. Officially it was released on August 1, 2012 and is just a
commercial version as of now.

Windows Server 2012 has four editions: Foundation, Essentials, Standard and Datacenter.
Each one of them has their own limitations except the Datacenter version, which is also
the most expensive one.

This is an introductory tutorial that explains all the fundamentals of Windows Server 2012.

Audience

This tutorial has been designed for all those readers who want to learn the features of
Windows Server 2012. It is especially going to be useful for all those professionals who
are required to install and use this operating system to perform various duties in their
respective organizations.

Prerequisites

We assume the readers of this tutorial have a practical experience of handling a Windows-
based Servers. In addition, it is going to help if the readers have a basic knowledge of how
to install and use an operating system.

Disclaimer & Copyright

© Copyright 2016 by Tutorials Point (I) Pvt. Ltd.

All the content and graphics published in this e-book are the property of Tutorials Point (I)
Pvt. Ltd. The user of this e-book is prohibited to reuse, retain, copy, distribute or republish
any contents or a part of contents of this e-book in any manner without written consent
of the publisher.

We strive to update the contents of our website and tutorials as timely and as precisely as
possible, however, the contents may contain inaccuracies or errors. Tutorials Point (I) Pvt.
Ltd. provides no guarantee regarding the accuracy, timeliness or completeness of our
website or its contents including this tutorial. If you discover any errors on our website or
in this tutorial, please notify us at contact@tutorialspoint.com
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1. Windows Server 2012 — Overview

Windows Server 2012 codenamed Windows Server 8 is the most recent version of the
operating system from Microsoft regarding server management. But it is not the last one,
as the last one is Windows Server 2016. Officially it was released on August 15t, 2012 and
is being sold as a commercial version only.

&R Windows Server2012

Improvements in Windows Server 2012

The major Improvements on this version are as follows:

e It is ready to be integrated with cloud systems and it still can maintain the classic
features of local datacenters as a result Hyper-V Virtualization has new features
Hyper-v replicas, it allows you to create virtual machines replications between
clusters and storage systems.

¢ The Storage migration virtual disks can be moved to different physical storages,
Virtual machine snapshots, virtual machines can be deleted from the Hyper-v and
also from the virtual disks and it can be used directly without the need to shut
down the virtual machine.

e The Core server installation easily switches to GUI installation without the need
of reinstallation.

e Thefile server and storage service improvement is that it eliminates identical copies
in the same volumes as such and saves space.

¢ The Storage pools and storage spaces allows you to group the hard disks to
one or more storage pools then it allows to create virtual disks. It can add other
disks to the storage pools and make available to the users without impacting them.

¢ The iSCSI Target Server can offer block storage to other servers and applications
on the network using the iSCSI standard.

e Active Directory cloning can deploy additional domain controllers by cloning an
existing virtual domain controller.

'&j Mtutorialspoint
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The Windows Server 2012 has four editions: Foundation, Essentials, Standard and
Datacenter. Each one of them has their own limitation accept the Datacenter version
which is also the most expensive one.

The following table will show what is the right one for your business needs:

Specifications Foundation Essentials Standard Datacenter
I . . . . Volume licensing
Distribution OEM only Retail, volume licensing, OEM and OEM
Licensing Per server Per CPUpair + CAL
model
Proce§sc_>r chip 1 5 64
limit
Memory limit 32 GB 64 GB 4 TB
User limit 15 25 Unlimited
File sharing 1 standalone 1 standalone Unlimited
limits DFS root DFS root
. 50 RRAS 22y F.{RAS
Network Policy . connections, 50
connections and . .
and Access 10 IAS IAS connections, Unlimited
Services limits ; and 2 IAS
connections
Server Groups
Remote SgssekTOOte
Desktop . P Gateway only Unlimited
. Al Services
Services limits :
connections

tutorialspoint
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Either in 1 VM or
Vlrtu_allzatlon N/A 1 physical 2 VMs Unlimited
rights server, but not
both at once
Active
Directory Certificate Certificate Yes
Certificate Authorities only || Authorities only
Services
Hyper-V No No Yes
Server Core No No Yes
mode
Windows
Server Update No No Yes
Services

For finding out the cost of licensing you can click on the following link:

https://www.microsoft.com/en-us/server-cloud/products/windows-server-2012-
r2/purchasing.aspx

Pricing and licensing overview

Licensing Pricing Open
Edition ideal for.. Feature comparison
model NL (US$)
Datacervier Highly virtualized private and hybad Full Windows Server functionality with unlimited virtual Processor « $6,155
doud emronments nstandes CAL*
Standard Low density or non-virtualized Full Windows Server functionality with teo virtual Processor + $ag2
environments instances CAL*
Essentials Senall business emvironments for servers Simgpler interface, pre-configured connectivity 1o Server {25 User $501*°
with up to two processors cloud-based senices: one virtual instance of Essentials Limit}

Foundation  Economical general purpose server with General purpose Server functionality with no virtualization  Server (15 User OEM only
a single processor rights Limit)

i

i
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2. Windows Server 2012 — Installation

In this chapter, we will discuss regarding the requirements and prerequisites of the
Windows Server 2012.

System Requirements

Although most of the servers nowadays probably have the necessary requirements for
Windows Server 2012. It will certainly be useful to know them in case you want to upgrade
from an older system.

The main requirements are:

e CPU socket minimum 1.4 GHz (64-bit processor) or faster for single core and
Microsoft recommends is 3.1 GHz (64-bit processor) or faster multi-core.

¢ RAM memory minimum is 2GB, but Microsoft recommends 8GB.

e 160 GB hard disk with a 60 GB system partition space in your hard disk.

One important thing to note here is that the installation process itself will verify your
computer hardware and let you know if it qualifies for a Windows Server 2012 installation.
If not, then you will need to upgrade your hardware.

Installation

The following steps are to be adhered for the installation of Windows Server 2012.

Step 1: We can download the evaluation ISO of Windows Server 2012 R2 from the
following link:

https://www.microsoft.com/en-us/evalcenter/evaluate-windows-server-2012-r2

But you will need to sign in first with a Microsoft account like Hotmail for example in order
to complete the download and the good thing is that the evaluation period will last for 180
days, so you will have enough time to know if it will be the right product for you or not.

\Windawe Caniar 2M3 D)
6 WInoows Senver JU1Z & @l
Evauations | 180 days
) o
=t
Pleace sign 10 downlead Wiedose Server 2012 R2. If you have not registerad befora. you will e asted to do so.
Sgnln
el
Do pracacsolt cony en-ul evalconten evakamte-wndons-sennes-2LE- QS erutos 31

At the end, if you decide to buy the license of your Windows server 2012 R2. You can
purchase it online via a Microsoft online store found in -
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http://www.microsoftstore.com/store/msusa/en US/list/Windows-
Server/categoryID.70676900%icid=BusinessR _Software 80 Windows Server 112315

For the Enterprise solution, I would recommend to purchase it via a Microsoft partner that
is found in your country.

€ 9 rrecroschtstorecom c ;19 wE D 3§ N

\A/

Vindows Server

.
|
&

Sort by Relerance

Windows Server 2012
Ucense Pack

Microsoft

Windows Server 2012
Ucense Pack

Microsoft

Cosfigurs and manage wiud desizops Configore and marage vl dediaops The ¥ed doed

dows Server 2012 Remote ath ‘Windo

rver 2012 Remote busness. Conty

Desktop Serwces Desidop i
$169.00 $679.00 5500
*hkkkr 2

Step 2: After downloading the ISO of Microsoft, create a boot USB driver which can be
created with the Microsoft tool called Windows USB/DVD Download Tool and can be
downloaded from the following link:

https://www.microsoft.com/en-us/download/windows-usb-dvd-download-tool

After downloading the EXE file, open it and select the ISO file location and then click next
like in the following screenshot, and wait up to the end when the Boot USB is created.

F - X
B Microsoft Store

WINDOWS 7 USB/DVD DOWNLOAD TOOL Temms of use | Online help

Step 1 of 4: Choose ISO file

Source fle:  |C:\Windows_Server_R2.1SO

i

i
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Windows Server 2012

Step 3: After completing the above given steps, plug-in the USB to the server and wait
for a while till it loads the files. This will continue for about a couple of minutes as shown
in the following screenshot.

Step 4: After the files are loaded, you will see the screen of language settings of
installation, keyboard, time and currency format. Generally, all the default ones are also
good enough to start with. Click Next.

- Waodows %0 _——

B Windows Server 2012

Step 5: Click “Install now”.

e e

B8 Windows Server 2012
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Windows Server 2012

Step 6: Once you have clicked on Install Now, the setup will start and it will load all the
files and the screen will look as shown in the following screenshot.

Setup is starting

Step 7: Wait until the files are loaded and then you will see the following screen. Let's
select Windows Server 2012 DataCenter Evaluation (Server with GUI) and click Next.

11
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Step 8: Click "I accept the license terms” and then click on the Next button as shown in
the following screenshot.

MOCROSONT SOFTIARS LICERSE TLses

MOCROSON T WRDOWS W EVIR JOL) DATACINTIR

0 e ol pin Pense el D

Step 9: The following screen will appear. In “Driver Options” you can create a new
partition, delete or format the Hard disk. After you have done this process then you can
select the partition where the Windows server 2012 R2 will be installed in our case we
have one partition. Once all this is done, then click on Next.

12
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Step 10: Let’'s wait until this process finishes during this time and then the server will
reboot.

Getting e ready for mtalltion (4%

Step 11: Once the reboot is done the following screen will appear. Set the password for
the server and then click on “Finish”.

Settings

Type a password for the bullt-mn admnesiraton account thal you can use to Sgn in 10 this compater

User name

13
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Step 12: It will take some minutes until the setup finishes completely.

Finalizing your settings

Step 13: Once all this is done, you have completed the installation process and the
following screen will appear.

Congratulations!!!

Press Ctri+Alt+Delete to sign in

5:03

Monday, September 2

G 12

14
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3. Windows Server 2012 —Server Roles

Like the previous version, Windows Server 2012 has the following roles which can be used
and in the subsequent chapter, we will see how to install and configure the most important
ones.

The following picture shows all the roles. A small reminder! — Roles and Features are
the tools that you need to install or activate in order to complete your IT Administration
duties, without their installation you cannot do anything.

Before You Begin Selact one or more roles to install on the selected server,

Instaliation Type Roles

[T] Active Directory Certificate Services
[[] Active Directory Domain Services
Features [] Active Directory Federation Services
[[] Active Directory Lightweight Directory Services
[[] Active Directory Rights Management Services
[[] Application Server
[T] DHCP Server
[T] DNS Server
[] Fax Server
[m] File and Storage Services (2 of 12 instalied)
(] Hyper-V
[[] Network Policy and Access Services
[] Print and Document Services
Remote Access (1 of 3
O szr;otevbesktop Services
[[] Volume Activation Services
7] Web Server (I15)
[C] Windows Deployment Services
[T] Windows Server Essentials Experience
[[] Windows Server Update Services

15
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To add a role in the server we should adhere to the following steps:

Step 1: Click with the mouse on Server Manager which is found in the task bar as shown
in the following screenshot.

Server Manager

Step 2: After opening the “Server Manager”, click on the second option “Add roles and
features”.

16
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Step 3: The following screen will appear, then you can Click on the Next button.

DESTINATION SERVER

This wizard helps you install roles, role services, or features. You determine which roles, role services, or
: features to install based on the computing needs of your organization, such as sharing decuments, or
Installation Type hosting a website.

Server Sslection )
To remove roles, role services, or features:
Start the Remove Roles and Features Wizard
Before you continue, verify that the following tasks have been completed:

* The Administrator account has a strong password
* Network settings, such as static IP addresses, are configured
* The most current security updates from Windows Update are installed

If you must verify that any of the preceding prerequisites have been completed, close the wizard,
complete the steps, and then run the wizard again.

To continue, click Next.

[[] skip this page by default

< Previous | | Mext = | | Install | | Cancel

17
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Step 4: Select the Role-based or feature-based installation and then click on the Next
button.

. . DESTINATION SERVER
Select installation type oy,
Before You Begin Select the installation type. You can install roles and features on a running physical computer or virtual

machine, or on an offline virtual hard disk (VHD).

o ; (®) Role-based or feature-based installation
Server Selection ; : y
Configure a single server by adding roles, role services, and features.

) Remote Desktop Services installation

Install required role services for Virtual Desktop Infrastructure (VD)) to create a virtual machine-based
or session-based desktop deployment.

[<previous | [ Net> | | nstal | [ Cancel

18
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In the next screen that appears, you will have the following two options:

Option 1: Select a server from the server pool. This option is — if you want to install the
services in the physical server like being done in the following screenshot.

DESTINATION SERVER

Select destination server RS,
Before You Begin Select a server or a virtual hard disk on which to install roles and features.

Installation Type (®) Select a server from the server pool
() Select a virtual hard disk

Server Roles Server Pool
Features
Filter:
Name |P Address Operating System

Microsoft Windows Server 2012 R2 Standard

1 Computer(s) found

This page shows servers that are running Windows Server 2012, and that have been added by using the
Add Servers command in Server Manager. Offline servers and newly-added servers from which data
collection is still incomplete are not shown.

<Previous | [ Net> | | instal Cancel

19
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Option 2: Select a virtual Hard disk if you want to install the services in a virtual disk that
can be somewhere in the network storage. Take a look at the following screenshot for
better understanding.

i 3 DESTINATION SERVER
Select destination server
Before You Bagin Select a server or a virtual hard disk on which to install roles and features.
Installation Type () Select a server from the server pool
S (@ Select a virtual hard disk
Server Pool 1. Select a server on which to mount
the virtual hard disk (VHD).
Filer: | |
If you select a VHD file from a
: network share, that share must
Name IP Address Operating Syste: grant Read and Write permissions
11 VIl e  tothe computer (local system)
account of the server that you
selected to mount the VHD. User-
only account access is not
sufficient.
< [T B
1 Computer(s) found
Virtual Hard Disk 2, Select an offline VHD file on which

Windows Server 2012 is already
installed, and on which you want
to install roles and features.

\\ServerName\Path\OfflineVirtualHardDisk.vhd Hiommas:

| < Previous liNext > ‘ ‘ _Install | | Cancel I
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Step 5: The last step will be to check the service that you want to install, but in the
upcoming chapters we will continue this setup for each and every important services.

Select server roles T et
Before You Begin Select one or more roles to install on the selected server.
Installation Type Roles Description
erv:r Selection _D_ Al S\C[t)ivces?:;?s:;yt?cﬂi:te Services
' [J Active Directory Domain Services certification authorities and related
Features [T Active Directory Federation Services role services that allow you to issue
[[] Active Directory Lightweight Directory Services :::3‘::3:;?;:’:::‘ wading
[T] Active Directory Rights Management Services
[[] Application Server a2
[[] DHCP Server
[C] DNS Server
[T] Fax Server
|b [H] File and Storage Services (2 of 12 installed)
[ Hyper-v
[[] Network Policy and Access Services [l
[T] Print and Document Services
[b [W] Remote Access (1 of 3 installed)
[[] Remote Desktop Services s
<Previous | [ New> | | sl | [ Cancel

21
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4. Windows Server 2012 - PowerShell

Windows PowerShell is a command-line shell and scripting language designed
especially for system administration. It's analogue in Linux is called as Bash Scripting.
Built on the .NET Framework, Windows PowerShell helps IT professionals to control and
automate the administration of the Windows operating system and applications that run
on Windows Server environment.

Windows PowerShell commands, called cmdlets, let you manage the computers from the
command line. Windows PowerShell providers let you access data stores, such as the
Registry and Certificate Store, as easily as you access the file system.

In addition, Windows PowerShell has a rich expression parser and a fully developed
scripting language. So in simple words you can complete all the tasks that you do with
GUI and much more.

PowerShell Icon can be found in the task bar and in the start menu. Just by clicking on
the icon, it will open.

R T G

Windows Adminstrative
Server Manager PowerShe Tools

A -

- h

8

Control Panel

22
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To open it, just click on the icon and then the following screen will open and it means that
PowerShell is ready for you to work on.

-~

Ly Administrator: Windows PowerShell | = [ o

Windows PowersS
Copyright (C) 2014 Microsoft Corporation. All rights reserved.

PS C:\Users\Administrator> _

The latest version of PowerShell is 5.0 and to check what is installed in our server we type
the following command - :$PSVersionTable as shown in the following screenshot and
from the screen we also know that we have PSVersion 4.0

PS C:\Users\Adm nistrator> $PSVersionTable
Value

PSVersion

WSManStackVersion 3.
SerializationVersion w1205l
LRVersion .0.30319, 34209

BuildVersion .3.9600.17400

PSCompatibleVersions

PSRemotingProtocolVersion

PS C:\Users\Admmistrator> _

23
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To update with the latest version where it has more Cmdlets we have to download
Windows Management Framework 5.0 from the following link -

https://www.microsoft.com/en-us/download/details.aspx?id=50395 and install it.

8 htty microsoft.com/en-i

And you can download it for free.*

Get started >

/indows Management Framework 5.0

Windows Management Framework 5.0 includes updates to Windows PowerShell,
Windows PowerShell Desired State Configuration (DSC), Windows Remote Management
(WinRM), Windows Management Instrumentation (WMI). Release notes:
http://go.microsoft.com/fwlink/?LinkID=717903

PowerShell ISE

The Windows PowerShell Integrated Scripting Environment (ISE) is a host application
for Windows PowerShell. In Windows PowerShell ISE, you can run commands and write,
test, and debug scripts in a single Windows-based graphic user interface with multiline
editing, tab completion, syntax coloring, selective execution, context-sensitive help, and
support for right-to-left languages.

You can use menu items and keyboard shortcuts to perform many of the same tasks that
you would perform in the Windows PowerShell console. For example, when you debug a
script in the Windows PowerShell ISE, to set a line breakpoint in a script, right-click the
line of code, and then click Toggle Breakpoint.

24
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To open it you just go to Start — Search and then Type - PowerShell as shown in the

following screenshot.

Everywhere -

, Windows PowerShell

Windows P«

Windows |

er Options

g‘ Change |

werShell ISE
werShell (x86)

=)
=
z, Windows |

werShell ISE (x86)

wer-saving settings

Then click on Windows PowerShell ISE. Or click on the downward Arrow as shown in the

following screenshot.
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It will list all the applications installed on the server and then click on Windows PowerShell
ISE.

z Windows PowerShell (x86)

E Windows PowerShell ISE

E Windows PowerShell ISE (x86)

The following table will be open -

> 5

1 i

21 w1 =1 =1 ~1 21 =1 =1

It has three sections, which include - The PowerShell Console with humber 1, then
Scripting File nhumber 2 and the third is the Command Module where you can find the
module.

While creating the script you can run directly and see the result like the following example:

26

'&j Mtutorialspoint

EIMPLYEAEYLEARMNINEG



Windows Server 2012

¢ View Tooks Dedeg Addom Mep

4 4 A 0 B 8 =RNnal

PowerShell Basic Commands

There are a lot of PowerShell commands and it is very difficult to put in all these commands
in this tutorial, we will focus on some of the most important as well as basic commands of
PowerShell.

The first step is to go to the Get-Help command which gives you an explanation about how
to give a command and its parameter.

yJse »-ir'nn'l\tr‘afor‘\ L;gf He] p \_Ad ..p’;)-F
NAME
_-"-dd-:".pp;)-:Pa:l\;,ige
<string> [-DependencyPath <string[]>] [-ForceApplicationShu
[<«CommonParameters>]

Add-AppxPackage [-Path] <string> -Fm]1>1'er [DP;:HPde\,F'r-fh csfrmq[W ] [thb]-D—
[ For C»-»-Qph(:thln hutdo <

A d Ij -2.':(p_',-_ F' ac
[-Install,

Add-AppxPackage -MainP g
[-WhatIf] [-Confirm] mmonParameterss ]
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To get the list of Updates:

e Get-HotFix and to install a hot fix as follows
e Get-HotFix -id kb2741530
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5. Windows Server 2012 - Remote Management

Remote Management Service is one of the most important part pertaining to
administration of Windows Server 2012. Administration of servers is performed through
Windows Management Instrumentation. WMI instructions can be sent over network WinRM
“"Remote Management”.

By default this utility is enabled, you can check it by going to Server Manager —> then
click on Local Server as shown in the following screenshot.

@ v Server Manager * Local Server

i PROPERTIES

I22 Dashboard | siewamp
B Local Server
Computer name L s g

ii All Servers Workgroup WORKGROUP

W3 File and Storage Services D

g‘-| Remote Access

Windows Firewall Public: On

Remote management Enabled

Remote Desktop Enabled

NIC Teaming Disabled

Ethernet SIS D0 enabled

If in case it is disabled, you can enable it by Opening PowerShell and then typing Enable-
PSRemoting as shown in the screenshot given below.

There is another way to enable it - Click on “Server Manager” => Local Server, then
ENABLE Remote management.
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TOSTTOUaTY -w
B Local Server )
Computer name werrr—e

BE All Servers i WORKGROUP
W§ File and Storage Services P
=1 Remote Access
wind ewa Public: On
Remote manageme Disabled
Remote Desktop Enabled
Teaming Disabled
Etherne Jl |75 enabled
- .‘ L A ” 3 - g T
gt ¥ Yol e ' “ NS civer & & - SHoa’d

Adding a Server for Remote Management

To add other servers for remote management, follow the steps given below:

Step 1: Server Manager -> Dashboard -> Add other servers to manage.

B Canboard WELCOME TO SERVER MANAGER

Wit EW

LEAN MOSE

Step 2: If the servers are joined to the domain, you add the select option “Active
Directory™, in my case they are not joined, so I selected the second option "DNS” => In
the search Box, I added the IP of the server that has to be managed => click on a small
arrow => OK.
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l:«::»»: Directory DNS import l Selected
Seanci| E Computer
4 OTHER(1)

Name P Address By

|4

i 1 Computer(s) selected

B

ﬂ Help oK Cancel

Step 3: Go to Server Manager -> All Servers, you will see the server that you have added.
As my server is in the Work Group, I have to right click and click on - "Manage As” as
shown in the following screenshot.

_ '.. SERVERS
B2 Dashboard B a0 cerve
i Local Server
P v R
W5 Fie and Storage Services b erver Name Ped Addrers  Maragesbis Windows Actateon
gl Remote Access
- = AREPEIO QU o e ot ot ed G100 811 000 RIS N

WinEM Negotate authentcato

Computer Management

Remote Desktop Connecton

Windows PowerShell

Configure NIC Teamung

Configure Windows Automatc Feedback
EVENTS Manage As ..
' | Remove Server
p v Ww Refresh

r

\opy
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Step 4: Enter the credentials of the remote server as follows and then -> OK.

Enter User Account and Password
Enter the name and password of an account with user rights on the

selected servers,

For example, user, user@example.contoso.com, or domain\user name.

Entering a blank user name and password deletes cached credentials.

K. T

[ Remember my credentials

To remove a managed server, Right Click on server => Remove Server.

| -
Server Name

EVENTS

IPv4 Address Manageability

WAlN@F  Online - Performance counters not started  6/8/2016 4:15:47 PM

Filter jeol @ v @ v

Last Update

Add Roles and Features

Restart Server

Computer Management
Remote Desktop Connection
Windows PowerShell

Windows Act

00252-6012¢

Configure NIC Teaming
Configure Windows Automatic Feedback

Manage As ...

All events | 0 total

\ Remove Server

Filter jel

| Server Name ID  Severity S

Refresh
| Copy

te and Time
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6. Windows Server 2012 - Windows Firewall

The Windows Firewall with Advanced Security is a firewall that runs on the Windows Server
2012 and is turned on by default. The Firewall settings within Windows Server 2012 are
managed from within the Windows Firewall Microsoft Management Console. To set
Firewall settings perform the following steps:

Step 1: Click on the Server Manager from the task bar -> Click the Tools menu and select
Windows Firewall with Advanced Security.

Aztree Directory Admunntratve Center
Actve Dwrecrary Damans s Trusts
Active Dwrectory Module for Wiedows PowerShell

' Local Sesver Actve Direcrory Stes and Servces
B Al Servers Active Directory Users and Computen
W ADOS ADS! Eent
& DNS zmm_,,,mmw
#8 File and Storage Services b Defragenent and Optimice Drives
OnS
Evert Viewer
Croup Policy Management
SN Initetor
Loval Securey Pubcy

QOBC Dwta Sources (32-bin
ODBC Data Sources 164-bit)
Performance Momitor

ROLES AND SERVER GROUPS T S
Nules Lerver grougps 1 Servers tatal | Secuoty Canliguestion Wigsed
Saraces
i§ aoos 1 & DNs System Corfiguraton
System information
@ Manageatihity @ Manageabstay Vask Scheduler
Events Events W Firewall with Agvanced Security
Dugnostx
sennces Senaces W
Performance Performance Windows PowerShed (s86]
BPA results BPA results Windows PowerShes 15§

Windows PowerShet 158 6]

-

Step 2: To see the current configuration settings by selecting Windows Firewall
Properties from the MMC. This allows access to modify the settings for each of the
three firewall profiles, which are - Domain, Private and Public and IPsec settings.
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Aztve Dreciory Aderatratve Cantar

Arvve Deectory Domans snd Traen

i Danvboard Actve Dwectony Module 4or Wandows SowerShed

o Windows Firewall with Advanced Secunity |=lal x |
Fle Acton Vies Help

«« m B

WELCOME TO SERVER MANAGER

o = o = FRCE S
Windows Frewsll with Ads T N L y n
o v s [ILCC I ITR] Windows Firewall with Advanced Secutity on Local .
S Iuheund Sivies | i . Firmwall wit.
Outhound B Doman Profie | Pavate Profie | Pubke Profie | Feec Sstinge on 2GS T a
S thommg Pty ) ‘ Wrddews Ereaal Wit Advarces Secsy : [~ L - ot Pole
8 Conmection Security Rules | ; " Polcy
¢+ B Monitoang | Spachy bahvior for "o - ndte e e Bt Policy.
domen |
Overview e Hore Def st Peircy
Femwad stute On pecammenced| v
Domamn Profile | ‘ - - E nose / Regav
@ Wedown Frewal s on rbound comnections | Bock (Hetmst) v ! s
© rbount connections e 85 not match & nd Outound conrectors Mivve (et it - .
Otbourd commectons et 60 Fot netch
9o e s Fruwtel et Crvectors  Cumsenze | B erties
Private Profile |
] Frewal
Wb - 7] Seacly wettrge thee corer Wndows. [
© rbourt cormectione Pt #s rot match » nd 3= | Femwal behavior -
0 Oubourd cornvectons that 99 not nEch 2
Logorg
Pubhbc Profile s Active Soech e |
O Wndows Frewat s on woie Ay Cuomas |
© oo corractione Pug de ot ratcr o nd
O Oubourd corrmctors that de rot natch 8
- 'JS"--M';-‘“ i
~ [k |[ coew |
Getting Started R - .
A 6 S
Comate cormection securty adet 19 specly how Und when corvectors Setwoen congetees e 2 80nteaied wnd
protected by usng imtemet Protacel secsty (Paec)

Step 3: Applying custom rules, which will include the following two steps:

e Select either Inbound Rules or Outbound Rules under Windows Firewall with
Advanced Security on the left side of the management console. (As you Know
outbound traffic is the traffic generated from server towards the internet and
inbound traffic is vice versa). The rules that are currently enabled are denoted by
green checkbox icon, while disabled rules display a grey checkbox icon.

e Right-clicking a rule will allow you toggle enable/disable.
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Fle Acion View Help
e« 2 =
i

=M"':h ‘Nunc Group * jon |~

°“”°“: - Rt | rample inbound Block

g on Secwly © 2ctive Diractory Demain Controlter - Ec..  Active Diractory Domain Ser..
- sy © Active Dicectory Domein Controier - Ec...  Active Directory Domain Sev..
8 Active Directory Domain Controffer - LD...  Active Directory Domain Ser...
@ Active Directory Domain Controlfer - £D...  Active Directory Domain Ser..
@ Active Directory Domain Controller - LD Active Directory Domain Ser.
10 Active Directory Derain Controlles - Net... Active Directory Domain Ser._.
10 Active Directory Domain Controller - SA..  Active Directory Domain Ser._.
8 Active Directory Domain Controller - SA..  Active Directory Domain Ser...
€ Active Directory Domain Controfler - Sec.. Active Directory Domain Ser...
{0 Active Directory Domain Controler - Sec...  Active Directory Domain Ser...
{8 Active Directory Domain Controller - W3...  Active Directory Domain Ser..
{8 Active Directory Domain Controller (RPC)  Active Directory Domain Ser..
8 Active Divectory Demain Controfles {(RPC_. Active Directory Domain Ser._
8 Active Directory Web Services (TCP-in)

Profie
A
A
a1
A
A
A
A1
Al
A
A
Al
Al
A
A
A

qFFEFERRRFRRERELY

FEREFFREFEET

FEEEEEEECEEREEE

g
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How to Create a New Firewall Rule?

To create a new Firewall Rule, you have to adhere to the following steps:

Step 1: From the right side of either the Inbound Rules or Outbound Rules - click "New
Rule”.

]

Veem W__
e 2im . B

B iedoms Pt it A L —

~

Bs
{
3
i
{
i
i

2
i
g
¥

€ Actsve Directory Demnain Controlies - Net.. Active Dwectoy Domsain Ser...
8 Active Dicecrory Deman Controies - SA_
© Active Deeciony Deman Controter - SA_

OWMWCMASL Active Directory Domam Sex_
@ Actrve Deectory Demnun Controfie - Sec_

0 Activr Dieectony Demnun Controler - W3 Active Directory Domam Ser
& Active Doecrary Doman Contreies RPC)  Activn Directory Domain Ser_.
0 Active Deectory Deman Controlier (RPC..  Active Directory Domain Ser...
© Actoee Dvectony Wb Serices [TCP ) Active Directory Web Seraces
@ BranchCache Contont Retraval (HTTR-In)  BramchCache - Comters Rt
@ BranchCache Hosted Cache Server (NTT.. BuanchCache - Hosted Cach..
@ BranchCache Peer Dacovery (WSD-In)  BramchCache - Peer Dacove..
@ COM- Network Access IDCOM-in) COMe Network Access
@ COM- Remote Adrmimistrabon (DCOM-In) COMe Remate Adsminitrat...
© Core Networkng - I Unve Care Netmarbing
@ Core Networking - Destination Urveschs... Cere Netwerking
€ Core Networking - Dynamic Most Config... Core Networking
€ Core Networking - Dynamic Most Config..  Core Netwerking
) Core Networking - internet Group Mana.  Core Netwerking
€ Core Networking - PHTTPS (TCH-4n) Core Netmerbing
O Cote Netwarkmng - Pyt (P vteie) Core Netmorting
@ Corn Networkng - Muiticast Lutener Do Core Networking

Fa
FEFFFERRFFFR R bRRRRRFRIREREbG

<

v

<} - » <] -
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Step 2: Custom from the Rule Type radial button - click Next.

Rule Type
Select the type of frewal rule 10 create

Sheps

-
-
-
-
-
~
-

What type of nule would you lke to create ?

' Program
Rule that controls connections for 8 program

. Port

Rule that controls connections for a TCP or UDP port.
' Predefined:

| Actve Drectory Domen Services

Rule that controls connections for 8 Windows expenence.

® Custom
Custom nde

' tutorialspoint
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Step 3: Select the Program association for the Custom Firewall Rule as either All programs
or the path to a program - click Next.

Program

Specify the full program path and exacutable name of the program that this nie matches

Steps:
Rue Type Does this rule apply to all programs or a specific program?

Program
Protocol and Ports @ Al programs

Scope Fuie apples to al connections on the computer that match other nie properties.
Action
Profie
Name

) This program path:

Example- c\path'\program exe
%Programfiles

% \browser'browser exe
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Step 4: Protocol type field select the protocol type > click Next.

Protocol and Ports
Specify the protocols and ports to which this nule applies.

To which pods and protocols does this nie apply?

' tutorialspoint
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| Speckic Pods

{80

Example: 80, 443, 50005010

| A1 Pots
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Step 5: Select an IP address association for both local and remote addresses > click
Next.

Scope

Specfy the local and remote IP addresses to which this nule applies.

Steps:

Which local IP addresses does this rule apply to?
® Any IP addess

-
°
e
e () Thesz IP addresses:
°
-
°

Customize the nterface types to which this nde applies:
Which remote IP addresses does this rule apply to?
@ Any IP address

() These IP addresses:

40
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Step 6: Select an action to take on matching traffic > click Next.

Action
Specify the action to be taken when a connection matches the condtions specfied in the nie.

Steps:
What action should be taken when a connection matches the specfied conditions?

Rue Type
Program
- () Allow the connection
Prctocsl and Pots This includes connections that are protected with [Psec 2s wedl as those are not.
Scope
Action
Profis
Name

) Allow the connection if it is secure

This includes only connections that have been authenticated by using IPsec. Conneclions
:bbeseand_ghwmn [Psec properties and nies in the Connection Security
node

| Customize

‘e Block the connection
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Step 7: Select the profiles associated with the custom rule - click Next.

Profile
Specty the profiles for which this nule appies

Steps:
When does this nule apply?

Domain
Applas when a computer is connectad to ts coporate doman.

V' Private

Apples when a computer s connected to a pavate network location, such a3 3 home
or work place.

V' Public
Apphes when a computer is connectad to a public network location.
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Step 8: Put a name for your Firewall rule and an optional description - Finish.

Name
Specfy the name and description of this rule.

Steps:

Name:
| Example Inbound Block

Desciption § ;
This ne wal block incoming connections on port 80

Rule Type
Program

Protocol and Ports
Scope

Action

Profie

Name

L
L
2
L
B
-
*
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Step 9: The firewall rule can be found on the corresponding Rule tab, either inbound or
outbound depending on the type created. To disable or delete the rule find the rule in the
MMC, right-click it and select either Disable Rule or Delete.

o 2w = B

MName

) Active Diractory Domam Controler - |
8 Actrve Directory Domain Controlier -

0 Active Directory Domain Controller - L
@ Active Directory Domain Controfier - L
@ 2ctive Directory Domain Controlier - L
€ Active Directory Domain Controlier - |
@ Active Directory Domain Controtier - §
€ Actrve Duectary Domam Controlier - :
@ Actrve Oirectory Domain Controller -

9 Active Directory Domain Controller -

0 Active Directory Domain Centrolier - Wi
0 2ctive Directory Domain Cantrolier (RPC)
8 Active Directory Domain Controller (RPC.
0 Active Directory Web Services (TCP-In)
@ BeanchCache Contert Retrieval (HTTP-In)  BeachCache - Content Ratr.,
@ BranchCache Hosted Cache Server (HTT_  BranchCache - Hosted Cach...
@ BeanchCache Pees Dicovery (WSD-In)  BranchCache - Peer Dscove.,
© COM+ Network Access (DCOM-In) COM+ Netwaork Access
0 COM-+ Remcte Administration (DCOM-i8)  COM- Remocte Administrati.,
@ Coen Netwerking - D Unreacha... Come Netwerking

8 Core Netwodking - Destinaticn Unreacha...  Cere Networking
8 Cose Networking - Dynaric Host Config.. Cose Networking
) Core Netwerking - Dynamse Host Corfig.. Core Networking
0 Cove Netwedking - intermet Group Mana... Cere Netwecking
) Cove Netweding - IPHTTPS [TCP-1n) Cere Networking
@ Core Networking - Pvé (Pve-In) Cece Networting
@ Conr Networking - Multicast Listener Do Cave Netwerking
‘.lr—nu-.«..._um;.ﬁ....a.

d

|

R R R R R AR R R R AR R R R 1]

<

EEEEEEEEREEEEREEEEEEREEEEEEEREEEE
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7. Windows Server 2012 - Remote Desktop
Management

In this chapter, we will see how to enable remote desktop application. It is important
because this enables us to work remotely on the server. To do this, we have the following
two options. For the first option, we have to follow the steps given below.

Step 1: Go to Start > right click “This PC” > Properties.

Windows Administrative
Server Manager PowerShell Tools

v
Unpin from Start
Manage
Properties
Map network drive
Disconnect network drive

Resize

Control Panel Intemet Explorer

Desktop

tutorialspoint
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Step 2: On Left side click "Remote Setting”.

T ii» Control Panel » System and Secunty » System v & 1 , Saarch Control Panel o ]
Control Panel Home (%)
View basic information about your computer
& Device Mansger Windows edition
RS
B Advanced syem setings © 2013 Micosoh Comporstion Al rghs sened. g WiNAOWs Server2012 R2
System
Processon Inted(R) Xeon(R) CPU E3-1220 3 @ 3.10GH: 309 GH:
Installed memory (RAM): 146 GB
System type: 64-bit Operating Systern, «64-based processoe
Pen and Touch: No Pen or Touch Input is avadlable for this Display

Computer name, domain, and workgroup settings

Step 3: Check radio button “Allow Remote connection to this computer” and Check box
“Allow connection only from computers running Remote Desktop with Network Level
Authentication (recommended)” - click “Select Users”.

vstem Properties

Computer Name | Hardware | Advanced | Remote |

Remote Assistance

[ ]Allow Remote Assistance connections to this computer

Advanced

Remote Desktop

Choose an option, and then specify who can connect.
() Don't allow remote connections to this computer
(® Allow remote connections to this computer

[w] Allow connections only from computers running Remote
Desktop with Network Level Authentication (recommended)

| Select Users... |

| [ Appb
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Step 4: Click Add.

SFINTTT IV UMD | S

The users listed below can connect to this computer, and any members of
the Administrators group can connect even if they are not listed.

G Administrator

Administrator already has access.

Add... Remove

To create new user accounts or add users to other groups, go to Control
Panel and open User Accounts.

Step 5: Type user that you want to allow access. In my case, it is administrator - click
OK.

Select this object type:
Users or Built-in security principals
From this location:

Pty

Enter the object names to select (examples):
administratod
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For the second option, we need to follow the steps given below.

Step 1: Click on “Server Manage” - Local Server - click on “Enable” or Disable, if it is
Disabled.

(7 \

(€)=~ Server Manager * Local Server

B PROPERTIES
Dashboard . For ALTIRNOTSRD6

|
LComputer name =4

All Servers Vicokgraup WORKGROU?

Fie and Storage Senaces b Last checkad for updates

B, &=

Remote Access
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8. Windows Server 2012 - Resource Monitor

Resource Monitor is a great tool to identify which program/service is using resources like
program, applications, network connection and memory usages.

To open Resource Monitor, go to Server Manage - Tools.

Component Services
Computer Management

Coanection Manager Acminsstration Kit
Defragment and Optimize Drives

Event Viewer

Growp Policy Management
iSCS! Initiator

Local Secunty Pocy
Microsoft Azure Senvices
Network Policy Server
CDBC Data Sources (32-be)
ODEC Data Sources (64-be)

m

4 (reate 3 server group
) Performance Monitor
§ server fo coua services Remote Access Management
| | Resource Monitor
Reuting and Remote Access
Secunity Configuration Wizard
Services
System Configuration
System Information

5 Connectth

IOUPS

| Serverstctak |

Click on “Resource Monitor”, the First Section is “Overview”. It tells how much CPU is
consuming every application and on the right side of the table, it monitors in real time the
chart of CPU usage. The Memory tells how much memory every application is consuming
and in the right side of the table it is being monitored in real time in the chart of CPU
usage.

The Disk tab splits it by the different hard drives. This will show the current Disk I/O and
will show the disk usage per process. The network tab will show the processes and their
network bytes sent and received. It will also show the current TCP connections and what
ports are currently listening, IDs too.
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9. Windows Server 2012 - Active Directory

In this chapter, we will see how to Install Active Directory in Windows Server 2012 R2.
Many of us who have worked with the previous version run DCPROMO.EXE to install it,
but in the 2012 version, it is recommended by Microsoft not to use it anymore.

To continue with Installation follow the steps given below.

Step 1: Go to "“Server Manager” - Manage - Add Roles and Feature.

i LocsiServe
i A2 Serves
#§ Fie and Stomge Senvices 9

j- Remote Access

Step 2: Click the Next button.

DESTINATION SERVER

Before you begin ALTRNO1SR0S

This wizard helps you install roles, role services, or features. You determine which roles, role services, or
features to install based on the computing needs of your organization, such as sharing documents, or
Instaliation Type hosting a website.

Before You Begin

Server Selection ;
To remove roles, role services, or features:
Start the Remove Roles and Features Wizard
Before you continue, verify that the following tasks have been completed:

* The Administrator account has a strong password
* Network settings, such as static IP addresses, are configured
* The most current security updates from Windows Update are installed

If you must verify that any of the preceding prerequisites have been completed, close the wizard,
complete the steps, and then run the wizard again.

To continue, click Next.

[[] Skip this page by default

| < Previous Next > Install Cancel
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Step 3: As we are installing AAD on this machine, we will select "Role-based or feature-

based Installation” = Next.

Bsfore you Bsgn

SCITNATON VIt

Select installation type P ——

Select the matallation type. You cam matall roles aod festures on 3 running piyscal compoter or witus
machne o on am offme vrtual hars Sok (VD)

Server Salection

® Role based or festure based instaitation
Comfigure & ungie server by addeg roles, rolke services and features.

~ Remmote Desktop Services mstallation
Inszall reGuared cOle sevwces tor Virnaal Desitzp infrastrucaure (VD) 22 Oeate 2 wrtual machee-2ased
ST JOIRSN-Dced SeTRICE SepioyTene

[('.h_!ll Nea» | et Cancel |

Step 4: Click on “Select a server from the server pool”, this is the case when it will be

installed locally.

. . DESTINATION SEAVER
Select destination server cmmmsansns

Before vou Begn Select & server or 3 virtual hard disk on which 10 install roles and features.

Instatation Type ®7 Select a seever from the server pool
T

Server Roles Server Pool

Features

Name P Address Operating Syxtem

i

J

1 Computer(s) found
This page shows servers that are runring Windows Server 2012, and that have been added by using the
Add Servers d in Server Manager, Offine servers and newly-added servers from which data

collection is stll incomplete are not shown,

[(Pm;] Nuy] Install
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Step 5: Check mark in the box next to Active Directory Domain Services. A box will
be explaining additional roles services or features which are also required to install domain
services.

fis Add Roles and Features Wizard -]8] X

DESTINATION SERVER

Select server roles

X

Select one or more roles to install on the selected server.
Roles Description

a|  Active Directory Domain Services
r (AD DS) stores information about
objects on the network and makes
tove act federat ervice this information available to users
and network administrators. AD DS
uses domain controllers to give
network users access to permitted
resources anywhere on the network
through a single logon process.
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Step 6: Click Add Features.

Windows Server 2012

Add features that are required for Active Directory

Domain

You cannot install Active Directory Domain Services unless the
following role services or features are also installed,

Services?

4

4 Remote Server Administration Tools
4 Role Administration Tools

AD DS and AD LDS Tools

Active Directory module for Windows PowerShell

4 AD DS Tools

[Tools] Active Directory Administrative Center
[Tools] AD DS Snap-ins and Command-Line Tools

Include management tools (if applicable)

add Features ||

Cancel

Step 7: Check “Group Polic

y Management” > Next.

Select features

Before You Begn

Instadaton Type

Sarvec Selecuon

Server Roies
TN

ADDS

Confirmation

DESTINATION SERvER
=
Select one o moce features o install on the selected server.
Features Description
5 — - . ~|  NET Framework 3.5 combines the
. power of the NET Framework 2.0
b [B) NET Framework 45 Features (2 of 7 installed) APts with ew technologies for
b [ Background inteligent Transfer Service (3/TS) buiiding appications thet offer
[ Btlocker Drve Encryption appenling mer sshaciicasy protect
. your  personal identity
[ BitLocker Network Uniock information, enable seamiess and
[ BranchCache secure and provide
[ Csent for NFS the abdity 1o model 3 range of
business
(7 Dew processes.
[ Durect Pray
[T} Enkanced Storage
[ Fadlover Clustering
ll Groop Policy Management [nstalied l
(] %S Hostable Web Core
[J ink and Handwriting Services
<l " Bl
] [
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Step 8: Click the “Next” button.

Active Directory Domain Services
Befere 10U Bage Active Dwvecrory Doman Servcns (AD D) storet siormation sbout viens, compters and other dewer
on the netwark. wmwmmmwwumuuwmmc
2 E sharing and colfaboration between uters. AD DS 5 shio required for &
Teroér Salection quMWNMWMWWWnMM
Server Ficied Thingt to note
TN * To help ensure that users can stil 199 On 10 the Network in the case of » server cutage mital 2
| wos | of 1o domen conoler o 8
Cerfamption * AD U5 requeres 3 DNS server 15 be imtalied on the network. i you 3o not have » ONS server
mtalied, you will be prompted 10 mstall the DNS Server role on tha machine
¢ imtaiing AD DS wil also wutall the DFS Namesp OFS Repd and Foe Peph "=
which are requeed by AD DS

Step 9: Click “Install”.

Confirm installation selections

&

Before You Segn To nstall the followng roles, role or

instaliason Type [ Restart the dess server iy  requ

S Seecer Optonal § {sch a3 admune tocks) mght be daplayed on tha page because they have

, been selected automatically. ¥ you do not want to install these optional features, cick Previous o clear
Sererfons thesr chec boxer
Fexiuret

AD DS Actve Ditectory Doman Senvces
IR e
Role Adminestration Tooks
AD 05 and AD LDS Tooks
Actve Deectory modiule for Windows PowerShell
AD DS Tools
Actve Directory Admntratve Certer
AD 0S Snap-ins and Command-Line Tools

[Eraio] [ wee> || t |
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Installation Screen will come up now and you have to wait until installation bar completes.

DESTINATION SIRVIR

Installation progress

View installation progress

o Feature installation
_—

Configuration requered. Installation succeeded on WIN2012AD

Active Directory Domain Services
Additional steps are required to make this machine 3 domain controller.
Promote this server to 8 doman controller
ST Geoup Policy Management
— Remote Server Administration Tools
Role Administration Tools
AD DS and AD LDS Tools
Active Directory module for Windows PowerShell
AD DS Tools
Active Directory Administrative Center
AD DS Snap-Ins and Command-Line Tools

You can close this wizard without interrupting running tasks. View tagk progress or open this
a page again by ciciong Notfications in the command bar, and then Task Details.

Bport configuration settings

Now that the installation of DC role is finished, you have to configure it for you server.
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Step 10: Click “Server Manager” - Open the Notifications Pane by selecting the
Notifications icon from the top of the Server Manager. From the notification regarding
configuring AD DS (Active Directory Domain Services), click Promote this server to a
domain controller.

v f"'"\) | }' Manage Tools View Help
7, A 2

j, Post-deployment Configura. .
8 Dashboard WELCOME TO SERVER MANAGI
i Local Server ;‘,:-1' qu : on required for Active Directory Domair
W& Al Servers o & omoteMis server to 3 domain controller
- - U
i ADDS
= o Feature installation
W} File and Storage Services P QUICK START e
& Configuration required. Installation succeeded on
e =i
Add Roles and Features
TS NEW Task Details
Hide
LEARN MCRE
ROLES AND SERVER GROUPS
Roles: 2 Server groups: 1 Servers totalk 1
- = File and Storage
il ADDS [ || g g 1
Services
@ Manageability @ Manageability

Events Events

Services Performance

Performance BPA results

BPA results

Step 11: Click “"Add a new forest” - Insert your root domain name into the Root domain
name field. In my case, I have put “example.com”.

Deployment Configuration TARGET SERVER
S
Deployment Configuration )
Select the deployment operation
Domain Controller Options :
(U Add a domain controller to an existing domain
(O Add a new domain to an existing forest
@® Add a new forest
Specify the domain information for this operation
Root domain name example.com
57
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Step 12: Select a Domain and Forest functional level. Once selected fill in a DSRM

password in the provided password fields. The DSRM password is used when booting the
Domain Controller into recovery mode.

Domain Controller Options TARGET SERVER
[=—rn—x0]

Select functiona! level of the new forest and root domain

Forest functional level: | Windows Server 2012 R2 [~]
Domain functional level: [ Windows Server 2012 R2 [']

Specify domain controller capabilities

Type the Directory Services Restore Mode (DSRM) password

Password: escssssnsee

Confirm password: 00000000004

Step 13: In the next screen which shows up, there is a warning on the DNS Options tab,
click OK and then select Next.

= Active Directory Domain Services Configuration Wizard w|a) X

DNS Options TARGET SERVER

| A, A delegation for this DNS server cannot be created because the authoritative parent zone cannot be found... Show more x I

Deployment Configuration ) ; .
Specify DNS delegation options

Domain Controller Options

bt - TN dalamatsan
Lreate UND geiegatic

Additional Cptions
Paths

Review Options

Prerequisites Check A A delegation for this DNS server cannot be created because the
% authoritative parent zone cannot be found or it does not run Windows
DNS server. If you are integrating with an existing DNS infrastructure,
you should manually create a delegation to this DNS server in the

parent zone to ensure reliable name resolution from outside the
domain “example.org”. Otherwise, no action is required.

More about DNS delegation

< Previous l I Next > Install
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Step 14: Enter NETBIOS name and click “"Next”.

TARGET SERVER

Additional Options

Deployment Configuration : : : -
Verify the NetBIOS name assigned to the domain and change it if necessary
Domain Controller Options

DNS Options

The NetBIOS domain name: EXAMPLE

Paths
Review Options

Prerequisites Check

More about additional options

[ ] | [

Step 15: Select location of the SYSVOL, Log files and Database folders and then click
Next.

TARGET SERVER
Paths [ —

Specify the location of the AD DS database, log files, and SYSVOL
Database folder: C:\Windows\NTDS

Log files folderr  C:\Windows\NTDS

SYSVOL folder:  C:\Windows\SYSVOL

EIE]E]
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Step 16: Click “Install” and wait until it is finished. The server will restart several times.

TARGET SERVER

Prerequisites Check

[ ® Al prerequisite checks passed successfully, Click ‘Install’ to begin installation. Show more X l

Deployment Configuration - Y i . siacts g
Prerequisites need to be validated before Active Directory Domain Services is installed on this

Domain Controller Options | computer

DNS Options Rerun prerequisites check

Additicnal Options
Paths A View results
Cryprograpny aigontnms wnen estaiisning Security cnannel sessions.
Review Options
For more information about this setting, see Knowledge Base article 942564 (http://
go.microsoft.com/fwlink/?Linkld=104751),
A delegation for this DNS server cannot be created because the authoritative parent
zone cannot be found or it does not run Windows DNS server. If you are integrating
with an existing DNS infrastructure, you should manually create a delegation to this
DNS server in the parent zone to ensure reliable name resolution from outside the
domain “example.org”, Otherwise, no action is required,
@ Prerequisites Check Completed
@ Al prerequisite checks passed successfully. Click ‘Install’ to begin installation. v|

A Ifyou click Install, the server automatically reboots at the end of the promotion operation.

More about prerequisites

<PmnousH Next >

The installation is now complete.
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10. Windows Server 2012 - DC Accounts

In Windows 2012, creating account OU and group is nearly the same as in the previous
versions.

To Create an OU user, please follow the steps given below.

Step 1: Go to: Server Manager - Tools > Active Directory Users and Computers.

Manage Tools View Help

Active Directory Administrative Center

Active Directory Domains and Trusts

Active Directory Module for Windows PowerShell
- Active Directory Sites and Services

ADSI Edit

Step 2: To create an OU named Management. Right-click domain in Active Directory Users
and Computers, choose New and click Organizational Unit.

—
File Action View Help

CEIEEE EEEY R =51

] Active Directory Users and Com|| Name Type Description
b ) Saved Queries 3 mmmm——... Domain
4 73— | Deleaate Control Folder to store your favo...
b ) Builtin elegate Control...
b j Comput Find...
p 21 Domain Change Domain...
b [ Foreign3 Change Domain Controller...
= M
b ‘:J nag™ Raise domain functional level...
b L] Users
Operations Masters...
New 4 Computer
All Tasks 4 Contact
Refresh Group
Properties InetOrgPerson
mslmaging-PSPs
Help =
MSMQ Queue Alia
Organizational Unit
Printer
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Step 3: Type Management to name the OU. Check the Protect container from
accidental deletion option. This option will protect this object from accidental deletion.

?i;] Createin: [N com/

Management|
[w] Protect container from accidental deletion

62

' tutorialspoint

EIMPLYEAEYLEARRMINEG



Windows Server 2012

Step 4: To create a user, Right-click on the Management OU - click New > and then
click User.

e St e =
File Action View Help
e 2@ 40/ XDz Bm3aavdh
] Active Directory Users and Com|| Name Type Description
b | Saved Queries -y "
4 1 IR com ere are no items
p [ Builtin
p ] Computers
p 2. Domain Controllers
b [ | ForeignSecurityPrincipal:
b || Managed Service Accout
b [ Users
2 Manag .
(] Manag Delegate Control...
Move...
Find...
New ’ Computer
All Tasks » Contact
View » Group
Cut InetOrgl?etson
Delete mslmagmg-PSPs.
Rename MSMQ Qt:!eue Aha.s
Refresh Or.gamutlonal Unit
< Export List... L
Creates a new iten] | Properties
- | Shared Folder
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Step 5: Complete the field with the data of the users > then click Next.

IFlolian Liapi

f.llapi I@example.com

User logon name (pre-Windows 2000):
EXAMPLE  \ | |f.rapi

Step 6: Now type-in the password. Check on the tick box - User must change password
at next logon. The user will be forced to change the password when the user logs in >
Click Next - and then click Finish.

& Creste in: example com/Management

o [

Confirm password: |uoounu

(] User must change password at next logon

[T] User cannot change password
[] Password never expires
[ ] Account is disabled
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11. Windows Server 2012 - File System

In Windows Server 2012 a new file system it is presented with is caller Resilient File
System (ReFS).

The key attributes of ReFS include:

Maintaining a high level of data availability and reliability, even when the individual
underlying storage devices experience failures.

Providing a full, end-to-end resilient architecture when used in conjunction with
Storage Spaces. When used together, ReFS and Storage Spaces provide enhanced
resiliency to storage device failures.

The significant functionality included with ReFS is described below:

Integrity: ReFS stores data in a way that protects it from many of the common
errors that can normally cause data loss. When ReFS is used in conjunction with a
mirror space or a parity space, detected corruption — both metadata and user data,
when integrity streams are enabled — can be automatically repaired using the
alternate copy provided by Storage Spaces. In addition, there are Windows
PowerShell cmdlets (Get-FileIntegrity and Set-FileIntegrity) that you can use
to manage the integrity and disk scrubbing policies.

Availability: ReFS prioritizes the availability of data. Historically, file systems were
often susceptible to data corruption that would require the system to be taken
offline for repair. With ReFS, if corruption occurs, the repair process is both localized
to the area of corruption and performed online, requiring no volume downtime.
Although rare, if a volume does become corrupted or you choose not to use it with
a mirror space or a parity space, ReFS implements salvage, a feature that removes
the corrupt data from the namespace on a live volume and ensures that good data
is not adversely affected by non-repairable corrupt data. Because ReFS performs
all repair operations online, it does not have an offline chkdsk command.

Scalability: As the amount and size of data that is stored on computers continues
to rapidly increase, ReFS is designed to work well with extremely large data sets
— petabytes and larger — without performance impact. ReFS is not only designed
to support volume sizes of 264 bytes (allowed by Windows stack addresses), but
ReFS is also designed to support even larger volume sizes of up to 2778 bytes
using 16 KB cluster sizes. This format also supports 264 - 1-byte file sizes, 264
files in a directory and the same number of directories in a volume.

Proactive Error Correction: The integrity capabilities of ReFS are leveraged by a
data integrity scanner, which is also known as a scrubber. The integrity scanner

periodically scans the volume, identifying latent corruptions and proactively
triggering a repair of that corrupt data.
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When the metadata for a ReFS directory is corrupted, subfolders and their associated files
are automatically recovered. ReFS identifies and recovers the files while ReFS remains
online. Unrecoverable corruption of the ReFS directory metadata affects only those files
that are in the directory in which the corruption has occurred.

ReFS includes a new registry entry, RefsDisableLastAccessUpdate, which is the
equivalent of the previous NtfsDisableLastAccessUpdate registry entry. The new
storage command lets in Windows PowerShell are available (Get-FileIntegrity and Set-
FileIntegrity) for you to manage the integrity and disk scrubbing policies.
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12. Windows Server 2012 - Group Managed Service

Accounts

The Managed Service Accounts (MSA) was introduced in Windows Server 2008 R2 to
automatically manage (change) passwords of service accounts. Using MSA, you can
considerably reduce the risk of system accounts running system services being
compromised. MSA has one major problem which is the usage of such service account only
on one computer. It means that MSA Service Accounts cannot work with cluster or NLB
services, which operate simultaneously on multiple servers and use the same account and
password. To fix this, Microsoft added the feature of Group Managed Service Accounts
(gMSA) to Windows Server 2012.

To create a gMSA, we should follow the steps given below:

Step 1: Create the KDS Root Key. This is used by the KDS service on DC to generate
passwords.

kY Administrator: Windc

N1NAOwWS pO.‘.ef"S e |
opyright (C) 2013 Microsoft Corporation. All rights reserved.

PS C:\Users\Administrator> add-kdsrootkey -effectiveimmediately

b22-62d5-f2f7-ee88-6bb5daefd85a

To use the key immediately in the test environment, you can run the PowerShell
command:

Add-KdsRootKey -EffectiveTime ((get-date).addhours(-10))

To check whether it creates successfully or not, we run the PowerShell command:

Get-KdsRootKey

Step 2: To create and configure gMSA - Open the Powershell terminal and type:

New - ADServiceAccount - name gmsal - DNSHostNamedcl.example.com -
PrincipalsAllowedToRetrieveManagedPassword "gmsalGroup"

In which,

e gmsal is the name of the gMSA account to be created.
e dcl.example.com is the DNS server Name.

¢ gmsalGroupis the active directory group which includes all systems that have to
be used. This group should be created before in the Groups.
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To check it, Go to - Server Manager - Tools & Active Directory Users and Computers >
Managed Service Accounts.

= Active Directory Use
File Action View Help

e 2m 0 EBc: BHm PaETER

. Active Directory Users and Com|[Name Type
b | Saved Queries " gmsal msDS-GroupManagedServiceAccount
agds

b | Builtin

b | Computers

2| Domain Controllers |
b ForeignSecurityPrincipal:}%
4 | Managed ServiceAccou{f

& gmsal

Step 3: To install gMAs on a server - open PowerShell terminal and type in the following
commands:

o Install - ADServiceAccount - Identity gmsal

e Test - ADServiceAccount gmsal

The result should come “True” after running the second command, as shown in the
screenshot given below.

X Adm

windows PowerShe
opyright (C) 2013 Microsoft Corporation. All m

PS C:\Users\Admjnistrator> insta11-adserviceacco
PS C:\Users\Administrator> test-adserviceaccount
rue

PS C:\Users\Administrator>
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Step 4: Go to service properties, specify that the service will be run with a gMSA account.
In the This account box in the Log on tab type the name of the service account. At the
end of the name use symbol $, the password need not to be specified. After the changes
are saved, the service has to be restarted.

| General| Log On | Recovery | Dependencies |
Log on as:

() Local System account
[ ] Allow service to interact with desktop

@® This account: " EXAMPLE\gmsa1$

Password:

Confirm password:

The account will get the “Log On as a Service” and the password will be retrieved
automatically.
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13. Windows Server 2012 - Group Policy Overview

The features of Group Policy Management were installed during the DC Role Installation.
Many of the management features haven’t changed as compared to the previous versions
of Windows Server. To create a GPO (Group Policy Overview), we need to follow the steps
given below.

Step 1: To create a GPO open the Group Policy Management Console (GPMC), go to
Server Manager 2> Tools > Group Policy Management as shown in the screenshot
below.

Manage Tools View

Active Directory Administrative Center
Active Directory Domains and Trusts
Active Directory Module for Windows PowerShel|
Active Directory Sites and Services

Active Directory Users and Computers
5 ADSI Edit

]

Compaonent Services

®
Z

Computer Management

5 Defragment and Optimize Drives

= DNS

Pe Event Viewer

:
1 nitiator

70

@' tutorialspoint

EIMPLYEAEYLEARMNINEG



Windows Server 2012

Step 2: Right-click on an OU > select the first option Create a GPO in this domain and
Link it here

& File Action View Window Help
o 2@ 0 XE G
& Group Policy Management FW Users

4 £\ Forest: firewall.local Linked Group Policy Objects i
4 (55 Domains l‘—l

4 Fg example.com \ Link rder GPO
=i/ Default Domain Policy =
p 2] Domain Controllers

@ Create a GPO in this domain, and Link it here...
b [ Group . =
b (5 WMIFi Link an Existing GPO
b (3 Starter Block Inheritance
b (g8 Sites Group Policy Update...
5% Group Policy !
"%, Group Policy F

Group Policy Modeling Wizard...
New Organizational Unit
| View »
New Window from Here
Delete

Rename
Refresh

Properties

Step 3: Type the Name for this GPO object - click OK button. We have selected the name
as Test GPO.

Source Starter GPO:
{none)
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Step 4: Right-click the GPO object and click Edit.

|z File Action View Window Help
e« 2m 0 XE Q| HE
.3 Group Policy Management FW Users
4 _ﬂ _Fc_:rest: firewall.local Linked G Policy O
4 35 Domains
4 F3 firewalllocal Link Orde
»/ Default Domain Policy yay 1
b 2] Domain Controllers o
4 3] FW Users
5 Test , r@==
» (5 Group Policy|  |ES®-
b [ WMI Filters Enforced
b [ Starter GPOs || v/ | | Link Enabled
b i Sites Save Report...
5% Group Policy Modelin _
"%, Group Policy Results New Window from Here
Delete
Rename
Refresh
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14. Windows Server 2012 - DHCP Role

As you know Dynamic Host Configuration Protocol (DHCP) is commonly implemented
network services in today’s network environments. DHCP is primarily used to automatically
distribute IP configuration settings to network clients, eliminating manually configuring
hosts on TCP/IP-based networks.

To Install DHCP role, you will have to follow the steps given below.

Step 1: Go to “Server Manager” - Manage - Add Roles and Features.

| Add Roles and Features
' \ Remove Roles and Features

Add Servers

Create Server Group

Server Manager Properties

Step 2: Click Next

Before you begin

Installation Type

Server Selaction

DESTINATION SERVER

This wizard helps you install roles, role services, or features. You determine which roles, role services, or
features to install based on the computing needs of your organization, such as sharing documents, or
hosting a website.

To remove roles, role services, or features:
Start the Remove Roles and Features Wizard

Before you continue, verify that the following tasks have been completed:

* The Administrator account has a strong password
* Network settings, such as static |P addresses, are configured
* The most current security updates from Windows Update are installed

If you must verify that any of the preceding prerequisites have been completed, close the wizard,
complete the steps, and then run the wizard again.

To continue, click Next.

[[] Skip this page by default

= i
< Previous i Install
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Step 3: Select the Role-based or feature-based installation option > click Next.

DESTINATION SERVER

Select installation type

Select the installation type. You can install roles and features on a running physical computer or virtual
machine, or on an offline virtual hard disk (VHD).

Before You Begin

le- or feature- instal
Configure a single server by adding roles, role services, and features.

0]

Server Selection

() Remote Desktop Services installation
Install required role services for Virtual Desktop Infrastructure (VDI) to create a virtual machine-based

or session-based desktop deployment.

| <previous || Net> ] | sl || Conce
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Step 4: We will install a Local DHCP Role as it will Select a server from the Server Pool >
then click Next.

DESTINATION SERVER

Select destination server

Before You Begin Select a server or a virtual hard disk on which to install roles and features.

Instaliation Type (@) Select a server from the server pool

() Select a virtual hard disk

Server Roles Server Pool
Featurss

Filter: |

|P Address Operating System

192,168,040 Microsoft Windows Server 2012 Datacenter Evaluation

1 Computer(s) found

This page shows servers that are running Windows Server 2012, and that have been added by using the
Add Servers command in Server Manager. Offline servers and newly-added servers from which data
collection is still incomplete are not shown.
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Step 5: From the Roles lists, check the DHCP Server role - click Add Features on the
popup windows as shown in the following screenshots.

DESTINATION SERVER

Select server roles

Before You Begin Select one or more roles to install on the selected server.

Instaliation Type Roles Description

Server Selection S : ) Dynamic Host Configuration
B - [ Active Directory Certificate Services Protocol (DHCP) Server enables you

[Vl Active Directory Domain Services (Installed) to centrally configure, manage, and
Features [C] Active Directory Federation Services provide temporary IP addresses and
DHCP Server [] Active Directory Lightweight Directory Services c’f.‘::"mie";mm" for client
Confirmation [[] Active Directory Rights Management Services

[[] Application Server

™

[V] DNS Server (Installed)

[[] Fax Server

[] File And Storage Services (Installed)
[] Hyper-v

[[] Network Policy and Access Services
[ print and Document Services

[[] Remote Access

[C] Remote Desktop Services

Add features that are required for DHCP Server?

The following tools are required to manage this feature, but do not
have to be installed on the same server.

4 Remote Server Administration Tools
4 Role Administration Tools
[Tools] DHCP Server Tools

Include management tools (if applicable)

| et
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Step 6: Click Next.

Select features

Before You Begin
Installation Type

Select one or more features to install on the selected server.

Server Selection

SSIVENROES b [®] .MET Framewark 4.5 Features (Installed)

p O Background Intelligent Transfer Service (BITS)
[] BitLocker Drive Encryption
[ BitLocker Metwaork Unlock
[] BranchCache
[] Client for NFS
[] Data Center Bridging
[] Enhanced Storage
[] Failover Clustering
Group Policy Management (Installed)

DHCP Server

Confirmation

[ Ink and Handwriting Services
[] Internet Printing Client
[ Ip Address Management (IPAM) Server

1 omem - -

Windows Server 2012

DESTINATION SERVER

Description

.NET Framework 3.5 combines the
power of the .NET Framework 2.0
APls with new technologies for
building applications that offer
appealing user interfaces, protect
your customers' personal identity
information, enable seamless and
secure communication, and provide
the ability to model a range of
business processes.

install | [ Cancel

Step 7: Click Next.

DHCP Server

The Dynamc Host Confs

Before You Bagin 2
Insz2liaion Type

Sarver Ssisction

Protocol aliows servers to assign, or lease, IP addresses to computers
and other devices that are enabled as DHCP clients. Deploying 2 DHCP server on the network provides
computers and other TCP/#P-based network devices with valid IP addresses and the additional

xon parameters these devices need, called DHCP options. This afiows computers and devices

0 connect to other natwork resources, such as DNS servers, WINS senvers, and routers.

Server foles

Featurss Things to note:

— * You should configure at least one static [P address on this computer.

Confirmation

in a safe place for later reference.

Mcee information about DHCP Sarver

o ]
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Step 8: Click Install.

Confirm installation selections

Befors You Bzan To install the following roles, role services, or faatures on selected server, ciick Install.

Insta¥asion Type

Sarver Szlzcton Optional # {such as admini tools) maght be displayed on this page because they have

” been selectad automatically. i you do not want to install these optional features, click Previous to clear
Seryer Roles their chack b
Fezturss

DHCP Server DVHCR Server
R
Role Administration Tools
DHCP Server Tocls

Export configuration settings
Specify an aternate source path

Step 9: Click Close.

Installation progress
View installation progress

owm
e}

Conliguration required. installabon succended on

DHCP Server
Launch the DHCP post-mstall wizard
Complete DHCP cond ’
Remote Server Admanistration Tooks
Role Admunistration Tooks
DHCP Seever Tools

e}

You can dose this wizard without intermupting running tasks. View task progress or open this
page again by clicking Notifications in the command bar, and then Task Details

Erport configuration settings

=Desos e o
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Post-deployment Configuration

In this section, we will see how to do the post-deployment configuration of the DHCP.

Please follow the steps given below.

Step 1: Click on the warning icon and then click on "Complete DHCP Configuration”.

Post-deployment Configura...

Configuration required for DHCP Server at
server.example.com

Complete DHCP confiquration

o Feature installation
= ————— ]

Configuration required. Installation succeeded on
server.example,com
Add Roles and Features

Task Details

'&j tutorialspoint
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Step 2: Click Next.

Description

I [ oo
target computer:

Authorization
Create the following security groups for defegation of DHCP Server Administration.
- DHCP Admimistrators
- DHCP Users

Agthorize DHCP server on target computer (f domain joined).

Step 3: Select a domain user account that has permissions to create objects in the Net
Services container in Active directory or a domain admin account - click Next.

Authorization

Speaiy the credentials to be usad to authorize this DHCP server in AD DS.

daeioﬂmvgzse(smdmn‘ab

EXAMPLE\administrator
User Name:
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Step 4: Click Close.

=

Summary

The status of the post install configuration steps are indicated below:

Please restart the DHCP server service on the target computer for the security groups to be
effective.

Authorizing DHCP server cisssssssssssn Done

Scope Implementation of DHCP

Now we have to configure the service to make it useful for the computers. To do this, we
need to follow the steps given below.

Step 1: Server Manager screen - Tools > DHCP.

Manage Tools View

Active Directory Administrative Center

Active Directory Domains and Trusts

Active Directory Module for Windows PowerShell
Active Directory Sites and Services

Active Directory Users and Computers

ADSI Edit

Component Services

Computer Management

Defragment and Optimize Drives

DNS

- .
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Step 2: Right-click on the DHCP Server - then click on “Add/Remove Bindings... "

File Action View Help

e m XDz Ha B2

mple.com  IPvd

PV =R dd/Remove Bindingse: |

Unauthorize
| Backup...
Restore...
Al Tasks

More Actions

| View

, Delete
Refresh
|Bpontit
EVProperties
Hdé

<] m IE

Add or Remove bindings from this server
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Step 3: Ensure the static IP address of the server should appear as shown in the following
screenshot.

IPvd | IPvE

Select the connections that the DHCP server supports for servicing clients. If this list is
empty, verify that a static IP address is configured for this computer.

Connections and server bindings:
%] 192.168.040 Ethemet
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Step 4: Right-click on IPv4 - Select "New Scope”.

File Action View Help
o= =2

@ DHCP WJ Name
2 § soveranple

b i IPvA BIPv6 Display Statistics...
g play

More Actions »

New Multicast Scope... ﬁ

Configure Failover..;
Replicate Failover Scopes...

More Actions »

Define User Classes...
Define Vendor Classes...

Reconcile All Scopes...
‘ Set Predefined Options...
| e L
| Properties
. Help

K T ey

Create a new scope
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Step 5: Click "Next".

New Scope Wizard

Welcome to the New Scope
Wizard

This wizard helps you set up a scope for distributing IP
addresses to computers on your network

To continue, click Next.,

]Cancel}

Step 6: Enter Scope Name and description as shown in the following screenshot and then

- Next.
New Scope Wizard
Scope Name
You have 1o provide an identfying scope name. You also have the option of providing
a description
Type a name and description for this scope. This information helps you quickly identfy
how the scope is to be used on your network
Name | Computers Scope
Descrption Computers DHCP Scope
< Back Next > Cancel
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Step 7: Enter the Start and End IP address, the Subnet mask, leave the Length as default
“24" for class C subnet - click Next.

IP Address Range
You define the scope address range by identifying a set of consecutive IP addresses.

~ Configuration settings for DHCP Server
Enter the range of addresses that the scope distributes.
Start IP address: [ 192.168. 0 . 100

End IP address: |192.168. 0 . 200

~ Configuration settings that propagate to DHCP Client

Length: 24
Subnet mask: [ 255.255.255. 0

e ]

Step 8: Enter your IP range in the exclusion list. If you have devices on the network that
require static IP address and also ensure that the excluded range falls with the Start and

End range earlier specified, then > click Next.

Add Exclusions and Delay

Exclusions are addresses or a range of addresses that are not distributed by the
server. A delay is the time duration by which the server will delay the transmission of a
DHCPOFFER message.

Type the IP address range that you want to exclude. if you want to exclude a single
address, type an address in Start IP address only.

Start IP address: End IP address:
M.

Excluded address range:
192.168.0.100to0 152.168.0.110

| <Bock | Net> |
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Step 9: Enter the desired lease duration for the assigned IP’s or leave as default > then
click Next.

Lease Duration
The lease duration specffies how long a client can use an IP address from this scope.

Lease durations should typically be equal to the average time the computer is
connected to the same physical network. For mobile networks that consist mainly of
portable computers or dial-up clients, shorter lease durations can be useful.
Likewise, for a stable network that consists mainly of desktop computers at fixed
locations, longer lease durations are more appropriate.

Set the duration for scope leases when distributed by this server.
Limited to:
Days: Hours:  Minutes:

5 [ [

Step 10: Select > Yes, I want to configure these options now to configure the DHCP
options for the new scope 2 then click on Next.

Configure DHCP Options
You have to configure the most common DHCP options before chents can use the
scope.

When clients obtain an address, they are given DHCP options such as the IP
addresses of routers (defaulk gateways), DNS servers, and WINS settings for that
scope.

The settings you select here are for this scope and overide settings configured in the
Server Options folder for this server.

Do you want to configure the DHCP options for this scope now?

" Ng. | will configure these options later
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Step 11: Enter the default gateway which is the IP of your Router - then click Next.

Router (Default Gateway)
You can specy the routers, or default gateways, to be distibuted by this scope.

To add an IP address for a router used by clients, enter the address below.
IP address:

Step 12: Add DNS IP - click Next (we can put Google DNS or if it is a Domain environment
you can put the DC IP there) then click > Next.

Domain Name and DNS Servers
The Domain Name System (DNS) maps and translates domain names used by clients
on your network.

You can specify the parent domain you want the client computers on your network to use for
DNS name resolution.

Parent domain: I example.com

To configure scope clients to use DNS servers on your network, enter the IP addresses for those
servers.

Server name: IP address:

| |
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Step 13: Specify your WINS Server if any and then click > Next.

WINS Servers
Computers running Windows can use WINS servers to convert NetBIOS computer
names to |P addresses.

Entering server |IP addresses here enables Windows clients to query WINS before they use
broadcasts to register and resolve NetBIOS names.

Server name: IP address:
I e
Resolve l 7

To change this behavior for Windows DHCP clients modify option 046, WINS/NBT Node
Type. in Scope Options.

o [=n

Step 14: Select Yes, I want to activate this scope now option to activate the scope
immediately and then click > Next.

Activate Scope

Clients can obtain address leases only f a scope is activated

Do you want to activate this scope now?

| @ IYes. | want o activate this scope now

" No, | wil activate this scope later
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Step 15: Click Finish.

New Scope Wizard

Completing the New Scope
Wizard

You have successfully completed the New Scope wizard.

To provide high availability for this scope, configure failover for
the newly added scope by right clicking on the scope and
clicking on configure failover.

To close this wizard, click Finish.

tutorialspoint
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15. Windows Server 2012 — DNS Role

DNS Role is one of the most important services in a network with Domain Controllers
Environment. It helps us to resolve domain names internally and externally to IP and to
have access to the requested service for the respective domain.

Let us now see how to install the DNS Role. For this we need to follow the steps given
below.

Step 1: To Install DNS role, go to “Server Manager” - Manage - Add Roles and Features.

Manage Tools View Help

| Add Roles and Features
: \ Remove Roles and Features

Add Servers
Create Server Group

| Server Manager Properties

Step 2: Click Next.

DESTINATION SERVER

Before you begin

This wizard helps you install roles, role services, or features. You determine which roles, role services, or
features to install based on the computing needs of your organization, such as sharing documents, or
Installation Type hosting a website.

Server Selection .
To remove roles, role services, or features:

Start the Remove Roles and Features Wizard
Before you continue, verify that the following tasks have been completed:

* The Administrator account has a strong password
* Network settings, such as static IP addresses, are configured
* The most current security updates from Windows Update are installed

If you must verify that any of the preceding prerequisites have been completed, close the wizard,
complete the steps, and then run the wizard again.

To continue, click Next.

[[] Skip this page by default

| < Previous Install
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Step 3: Select the Role-based or feature-based installation option and then click
Next.

- DESTINATION SERVER
Select installation type s
Befors o Begn Select the installation type. You can install roles and features on a runmng physial computer or wriual
— maching or on an offine virtusl hard disk (YHD)
Saiet Selechion '® Role-based or teature-based installation
5 Configure & single server by adding roles, role services. and festures.
' Remote Desktop Services installation
Irstall required role services for Virtual Desktop Infrastructure (VD) to creste 2 virtus! machine-based
o sesuon-based desktop deployment.

Step 4: We will install a Local DNS role as it will select a server from the server pool >
and then click Next.

Select destination server

Before You Seain Select 2 server or a virtual hard disk on which to mstall roles and features.

@/ Select 2 server from the serverpool = = =
() Select 3 virtual hard disk

1 Computer(s) found

This page shows servers that are running Windows Server 2012 and that have been added by using the
Add Servers d in Server Manager. Offine servers and newly-added servers from which data
collection 1 still incompiete are not shown.

[ <previous | Nex> JI fnstall I Cancel
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Step 5: From the Server Roles lists, check the DNS Server role > click Add Features on
the popup windows and then click Next.

Select server roles = e
Before You Begin Select one or more roles to install on the selected server.
Installation Type Roles Description
Server Selaction [ - . ) "A]  Domain Name System (DNS) Server
N | Do O[] eoeenmemsue
[V Active Directory Domain Services (Installed) networks. DNS Server is easier to
Features [T Active Directory Federation Services manage when it is installed on the
DNS Server g ; y . 3 same server as Active Directory
Dkﬁvebf«torybghlwecght&mtoq&ﬂxes Oiats Sarvios: o 2
Confirmation [[] Active Directory Rights Management Services Active Directory Domain Services
[[] Application Server a role, you can install and configure
DNS Server and Active Directory
HCP Server
I:Sh Domain Services to work together.
[[] Fax Server
(b [®] File and Storage Services (2 of 12 installed)
[ Hyper-v

[[] Network Policy and Access Services
[C] Print and Document Services

[[] Remote Access

[[] Remote Desktop Services

v

F [ R

Add features that are required for DNS Server?

The following tools are required to manage this feature, but do not
have to be installed on the same server,

! 4 Remote Server Administration Tools
4 Role Administration Tools
[Tocls] DNS Server Tools

Include management tools (if apphicable)

o] o
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Step 6: Click Next.

DESTINATION SERVER
DNS Server commmmnen,
Bafors You Begr Domain Name § (DNS} provid owwhmwmmm
mmmnmhmbnhb rk comp -byw-q...,..
installavon Type names inttead of & long series of numbers. In addition, DNS peovides a b
Server SelecTion mmmmmuuwmumﬂummeMw
can be integrated with Dynamic Host Configunation Protocol (DHCP) services on Windows, eliminating
Server Roles the need to add DNS records as computers are added to the network.
FRatuses
EETE
Confemason * DNS server integration with Active Directory Domain Services automatcally repicates DNS data

mmmmmmmnmmwm

ki-cf‘ y Ox Senvices requires a DNS server 10 be mitalled on the network If you are
d tier, you can also mstall the DNS Server role using Actve Directory Doman
mmmwmmmmmwmm

Step 7: Click Install.

- . a A DESTINATION SERVER
Confirm installation selections —_—
Before You Begin To install the following roles, role services, or features on selected server, click Install.
Instaliation Type [[] Restart the destination server ically if required
Server Selection Optional features (such as administration tools) might be displayed on this page because they have
been selected automatically. If you do not want to install these optional features, click Previous to clear
Server Roles their check boxes.
Features o
DNS Server DNS Server
- R Server Administration Tools
Role Administration Tools
DNS Server Tools
Export configuration settings

Specify an alternate source path

[<previous | [ next> | | wd[ Cancel |
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Step 8: Wait until installation bar is complete.

DESTINATION SERVER

Installation progress —_—

View installation progress

o Feature installation
1 —) 1
Installation started on  server.evamplec

DNS Server
Remote Server Administration Tools
Role Administration Tools
DNS Server Tools

You can close this wizard without interrupting running tasks, View task progress or open this
page again by clicking Notifications in the command bar, and then Task Details.

s

| < Previous 1 | Nexi > | I Close Cancel

Export configuration settings

Once the installation is finished, click on Close.
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16. Windows Server 2012 - Primary Zones

To manage DNS, we have to create a primary Zone because by default, there are no zones
in order to manage the records.

Step 1: To manage DNS, go to Server Manager - Tools - DNS - Right click on “Forward
Lookup Zone” > New Zone.

Component Services
Computer Management
Defragment and Optimize Drives
| DNS
Event Viewer
iSCSI Initiator
| Local Secunity Policy
| ODBC Data Sources (32-bit)
ODBC Data Sources (64-bit)
Performance Monitor
Resource Monitor
| Secunty Configuration Wizard

File Action View Helg
oo 2@ oz Bm iaa

2 DNS Name Type Status DNSSEC Status
4 i semreﬂnglﬁﬂm* - _msdcs, EXAMPLE.COM Active Directory-Integrated Pr...  Running Not Signed

b ,’__jjﬁé - | EXAMPLE.COM Active Directory-Integrated Pr...  Running Not Signed
b ] Rer New Zone..,

b Tn
b = Co
b Gl Refresh

Export List...

Help

View »
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Step 2: Select “"Primary Zone” and then click Next.

Zone Type
The DNS server supports various types of zones and storage.,

Select the type of zone you want to create:

(®) Primary zone
Creates a copy of a zone that can be updated directly on this server,

() Secondary zone
Creates a copy of a zone that exists on another server. This option helps balance
the processing load of primary servers and provides Fault tolerance,

() Stub zone

Creates a copy of a zone containing only Name Server (NS), Start of Authority
(SOA),mdpossﬂywoma(A)mwds A server containing a stub zone is not
authoritative for that zone,

[ Stare the zone in Active Directory (available only if DNS server is a writeable domain
controller)

Step 3: Enter the name of the primary Zone for which you want to manage the records.

Zone Kame
What 5 e name of $e new one?
The 20ne name spedfies the porton of the ONS namespace for which the server 5
authontatve. [t sght be your doman rame (%o exampie, mcoscft com)
o 3 portion of he doman name exampie, NEwONe MC0scft.com). The 200¢ name &
not the name of the DINS server
Zore rame:
| example.com |
< Back l Cancel I
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Step 4: Select “"Create a new file with this filename” option.

Zone File
You can creste 8 new 2one fie or use & fle copied from another DNS server,

Do you want to create 8 new 2one file or use an existing e that you have copied
from another DINS server?

(®) Create a new fie with this fie name:

prem— 1

() Use ths existing file:

To use ths existing file, ensure that it has been copred to the foider
%SystemRoot % system32\dng on ths server, and then dick Next.

et o> | [t |

Step 5: If you want to update the record of this zone manually, you have to select “"Do
not allow dynamic Updates”, as shown in the following screenshot.

Dynamic Update
You can specify that this DNS zone accepts secure, nonsecure, or no dynamic

updates.

Dynamic updates enable DNS dient computers to register and dynamically update their
resource records with a DNS server whenever changes occur.

Select the type of dynamic updates you want to allow:

_) Allow only secure dynamic updates (recommended for Active Directory)
This option is available only for Active Directory-integrated zones.

(O Allow both nonsecure and secure dynamic updates
Dynamic updates of resource records are accepted from any dient.

A This option is a significant security vulnerability because updates can be

accepted from untrusted sources.
(®) Do not allow dynamic updates
Dynamic updates of resource records are not accepted by this zone. You must update
these records manually.
< Back Next > Cancel
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Step 6: Click the Finish button.

Completing the New Zone Wizard

You have successfully completed the New Zone Wizard. You
specified the following settings:

Name: example.com ~

Type:  Standard Primary
Lookup type: Forward

File name: example.com.dns v

Note: You should now add records to the zone or ensure
that records are updated dynamically. You can then verify
name resolution using nslookup.

To dose this wizard and aeate the new zone, dick Finish.

= e
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17. Windows Server 2012 - Manage Records

As you know, in DNS you can add records according to your need and in Windows server
2012 as well. This doesn’t change too much from its earlier version of Windows Server
2008.

To add or manage records, we have to follow the steps given below:

Step 1: Server Manager » DNS - Right click on the server that has a DNS record, which
in our case is local.

n - - VS A S N\
Server Manager * DN

& SERVEIRS
a Dashboard A servers | 1 totyd

' Local Server
i] Al Servers

B3 Fide and Storage Secvices
A Fobes ard Features
et Down Local Server

Computer Maragement

Windows PowerShell
Configure NIC Tearnisy

A e aamatic Feedback
EVENTS v

Al eventy TASKS ¥
S2art Performance Counters

Retren

Copy

Server Name I Seventy Source 7 ste and Tiwe

SIRVER01Z 438 Warnng  Maorosoft- Windows DNS - Server-Servce  DNS Server 107177201 11:04:482 PV
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Step 2: Go to “"Forward Lookup Zone”.

File Action View Help
e 2mRTas Bm i@EQ

4 ] Forwaed Lookup Zones
“

| (23 Teust Powts
i Condtronal Forwarden
(L Root Hunts
& Formarders

3 1168.192n-addrarp)|
+ 1 Trust Pownts
3 . Condtional Forwardens
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Step 3: Right Click on the empty Field > New Host (A or AAAA) ...

File Action View Melp
e 2mSeE Bm iaa

rNum Type
[ ] tsame a5 parent tolder) St of Asthorty (SOA) 11l sarver hostmaster,
[ ] (same a5 pacent folder) Name Server (NS) server

4 [ Forward Lonkvio Zones
J axample.com |
4 [ Reverse Lookup Zones ‘

() 1.168192m-addrarp,
+ 10 Teust Points ‘
3 o] Condtons! Formarders
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Step 4: Name field and the subdomain name or case is WWW. - IP address we put is
192.168.1.200. So, when we will type-in our browser www.example.com, it will redirect

us to 192.168.1.200.

Name {Uses parent doman name if Dlark):
www

{qwmmaqm):

o

P addess

| 192.168.1.200

W Create assocated ponter (PTR) record

Step 5: To add a Mail Server Record, we add an MX record and then Right click > New
Mail Exchanger as shown in the screenshot given below

"' [ 7l
b Revel
7 Trust

Update Server Data File
Reload

psZones
Zones

p . Conc

New Host (A or AAARA)..

I arent folder)

b [E Globi

New Alias (CNAME)...

New Mail Exchanger (MX)...

' New Domain...
New Delegation..,
Other New Records..,
DNSSEC
All Tasks

View

Delete
Refresh

‘arent folder)
arent folder)

Start of Authority (SOA)
Name Server (NS)

Host (A)

Host (8)
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Windows Server 2012

Step 6: At “Fully qualifies domain name(FQDN) of mail server”, you enter the name of
mail server > then in the “Mail server priority”, you enter a number. The smaller the
number, the higher the priority.

L WA PV TUERA SN VRS VRS WRAVRTAV A

| Ml Exchanger (%) ‘_
Mcwm'

:

By defadt, DI wunes the paront doman name when Ceating a Mal
Excharge record. You can 9eofy 8 host or dhlkd rase, Bt in most
deployments, e above fiekd o left blark

Ay quiind donain rsme (P0G

{\‘!MNWWQWO‘MH\“:
[—hl.uw

Mol gorver pronty:
0
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18. Windows Server 2012 - IIS Overview

The IIS or Internet Information Services role is one of the most important services in
Windows Server 2012. It has improved features as compared to its previous versions and
it helps us to publish web application or webpages.

Let us now see how to install the IIS Role for which you will have to follow the steps given
below.

Step 1: To Install IIS role, go to “Server Manager” - then Manage - and then to Add
Roles and Features.

Manage Tools View Help

| Add Roles and Features
|| Remove Roles and Features

Add Servers
Create Server Group

| Server Manager Properties

Step 2: Click on Next in the window which pops up.

DESTNATON SERVER

Before you begin

This wizard helps you install roles, role senaces, or features. You determune which roles, role seraces, or
features to mstall based on the computing needs of your ceganization, such a3 sharing documents, ar
nitalavcn Type hosting & website,

Server Sekection
To remove roles, role services, or features:
Start the Remave Aoles and Festures Wicaed

Before you continue, verify that the foliowing tasis have been completed:

* The Admnstrator sccount has 8 strong password
* Network settings, such as static IP addrestes. are configured
* The mast current security updates from Windows Update are installed

If you must vendly that any of the preceding prerequisites have been completed, close the wizard,
complete the steps, and then run the wizard agamn,

To continue, chick Next

[1] Siop this page by default
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Step 3: Select the Role-based or feature-based installation option and then click on
Next.

. e DISTINATION SERVER
Select installation type
Ssfore You Begin s&ammm‘va.mmmem-mmmmmm
[ rsotocn e [
Sérver Seiaction '® Role-based or feature-based installation
R Configure 2 single server by adding roles, role senices and features.
_ Remote Desktop Services installation
Instail required role services for Virtual Desktop Infrastructure (VO] to create 3 virtual machine-based
or session-based desitop deployment.

Step 4: I will install a Local IIS role as it will Select a server from the server pool - then
click on Next.

DESTINATION SERVER

Select destination server

Before You Bagin Select a server or a virtual hard disk on which to install roles and features.

Installation Type (@ Select a server from the server pool
S S () Select 3 virtual hard disk

Server Roles Server Pool
Features

Filter: |

Name IP Address Operating System

192.168.040 Microsoft Windows Server 2012 Datacenter Evaluation

1 Computer(s) found

This page shows servers that are running Windows Server 2012, and that have been added by using the
Add Servers command in Server Manager. Offline servers and newly-added servers from which data
collection is still incomplete are not shown.

|<gmiom|nm>| | Install ]ICamel

106

' tutorialspoint

EIMPLYEAEYLEARRMINEG



Windows Server 2012

Step 5: From the Roles lists, check the "Web server” (IIS) Server role > Next.

Select server roles

Select one or more roles 10 install on the sefected server.

Before You Begin
instalation Type
Server Selection
| senernos |

Fastures
Web Server Role (45)

fAole Services
Confirmaticn

Step 6: Click Next.

Raoles

] Active Directory Rights Management Services
] Application Server
[} OHCP Server
] DNS Server
7] Fax Server
b (&) File And Stomge Services {Instalied)
[ Hyper-v
7] Network Policy and Access Services
7] Prnt and Document Services
[} Remote Access
[[J Remote Desictop Services
] Volume Actvation Services

7] Windows Server Update Services

et |

v

Description

Web Server [IIS) provides a reliable,

manageable, and scalable Web
application infrastrocture.

| Inatal | Cancel I

DESTINATION SERVER
Select features =
Sedare wou Begin Select one or more features to nstall on the selected server.
Inssaliation Type Description
Servir Selection A1l NET Framework 45 provides »
Server Rolgs wmm' and consistent
E ey
|b [ Background inteligent Transfer Service (BTS) | B1 | essily Nnnd mmngu
web Sarvar Role 1S . / applications that are buslt for various
we .erer‘o-u:) [ BitLocker Drve Encryption 4|  platiorms including deskiop $Cx
Rols Services [ Bittocker Network Uniock Servers, smant phones and the pubic
Confirmation 7] BranchCache and peivate doud.
[) Client for NFS '
[ Data Center Brdging
] Enhanced Storage
[ Failover Clustering
[ Group Poiicy Management
[0 tnk and Handwriting Sennces
] internet Printing Client
[ 1 Address Management (IPAM) Server
A w [ 1|
| e s
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Step 7: Click Next.

Web Server Role (lIS)

gzfors You Seon

Instafiation Type diagnostic and admini
Server Selaction Communication Foundation.
Server Roies Things to note:

Fezturss

Role Services
Confirmation

More information about Web Server IS

Windows Server 2012

DESTINATION SERVER

Web servers are computers that let you share information over the Interret, or through intranets and
2 unified Web platiorm that integrates IS 8.0, ASP.NET, and Windows

* Using Windows System Resource Manager (WSRM) can help ensure equitable servicing of Web
_ server traffic, especially when there are multiple roles on this computer.
* The default mstaiZation for the Web Server (IS) role includas the instaliation of role services that
enable you to serve static content make minor customzations (such as default documents and HTTP

E= W

Step 8: You can choose all the default setting or customize them according to you needs.

Select role services

Select the role services to install for Web Server (I1S)

Sefors vou S2gn
Instatiation Typé Role services
Sarver Selection ’

« v e
Server Rolas 4 [ Common KTTP Features
Features (V] Detault Decument
Web Server Sole (15) Directory Browsing
T oo
Confrmation 4 Static Content

HTTP Redirection

V] WebDAY Publishing
- Health and Diagnastics

[ KTTP Logging

(] Custom Logging

(¥ Logging Tocks

[ ODBC Logging

(¥ Request Monitor

< -

DESTINATION S3AVER

Web Server provides support for
HTML Web sites and optional
support for ASPNET, ASP, and Web
server extensions. You ¢an use the
Web Server to host an internal of
extamal Web site or 1o prowde an
environment for developers to
create Web-based appicatons.
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Step 9: Click Install.

» . . DISTINATION $ERvER
Confirm installation selections ——
Sefore wou B2gn To install the following roles, role services, of features on selected server, click install
installaton Type (1 Restart the destinaticn server sutomatically if required T ey
Sarver Selecuon Optional features (such a3 ad: tooks) mught be displayed on this page because they have
or R been selected avtomatically, If you do not want 10 install these cpbonal features, chick Previous to clear
Server RO their check boxes.
Foanures =
Web Server Roke 01S) NET Framework 45 Festures +-
RoM Services PP [;
oo M |
Web Server
Common HTTP Festures
Static Content
Defaylt Document
Directory Browsing
HTTP Ermors
HTTP Redirection
Export configuration settings
Specity an alternate source path
s | bt ] Concel |

Step 10: Wait until the Installation Wizard finishes. Once it is done click Close.

Installation progress sesTATON seRvR

View instaifabion progress

o Festure installation
. ————————————

Installation succeeded on (NG

NET Framework 4.5 Features
ASPNET 45
Web Server (1IS)
Web Server
Common HTTP Features
ET Staic Contet
Default Document
Directory Browsing
HTTP Errores
HTTP Redirection [
WebDAV Publishing d

> |

You can diose this wizard without interrupting running tasks. View task progress or open this
page again by clicking Notifications in the command bar, and then Task Detads.

Export configuration setbngs

< Previous Next > ” Close !I Cancel
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Step 11: Check if your IIS is installed correctly. This can be done by opening your internet
explorer and then typing http://localhost and you should be able to see the following
screenshot.

| |8 sviosomsens x|

28 Windows Server

Internet Information Services

Welcome Bienvenue Tervetuloa

£5c# Benvenuto

L 3 ." Bienvenido Hos geldiniz

Bem-vindo ‘ '
KoAwg
Vitejte Oploate

Microsoft Velkommen
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http://localhost/

19. Windows Server 2012 - [IS Security

The IIS (Internet Information Services) is facing internet all the time. So, it is
important to follow some rules in order to minimize the risk of being hacked or having any
other security issues. The first rule is to take all the updates of the system regularly. The
second one is to create different application polls to this, which can be done by following
the steps shown below.

Step 1: You have to go to: Server Manager 2 Internet Information Services(IIS) Manager
- Application Pulls.

File View Help
_e,- B2 18, | @.’ Application Pools
Wy Start Page Thi . . 0 $ L : :
¢ — is page lets you view and manage the hist of application pools on the server. Application pools are associated with
’ worker processes, contain one or more applications, and provide isolation among different applications,
b {&) Sites Filter: * ¥ Go - (ghShow All | Group by: No Grouping .
Name Status  NET Framework Version  Managed Pipeline Mode  Identity v
{42 NET v20 Stated  v20 Integrated ApplicationPoolldentit
UFNETV20 Classic  Started  v20 Classic ApplicationPoolldentit
UYNET WS Started W40 Integrated ApplicationPoolldentit;
¥ NET 4.5 Classic Stated w0 Classic ApplicationPoolldentit
X Classic NET AppPool Started  v2.0 Classic ApplicationPoolldentit
Y DefaultAppPool Started W0 Integrated ApplicationPoolldentit:
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Step 2: Click "Sites” - Right Click “Default Website” - Manage Website - Advance

Settings.

File View Help

(Comnections
e iz 8

& Start Page

0 Default Web Site Home

@' tutorialspoint
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ilter: v ¥ v Al
495 WIN-QUK2MQFTH (WIN-QOK2MQOFT | " ¥ Go - (& Show Al
-2} Application Pools ASP.NET
4-[8] Sites 2 $ - e
: e = 4
b @ Defoult == \~ i 0
- NET  NETEmor  .NET
Edit Permissions... at.. Compilation Pages  Globalizatiot
S’ Add Application... ‘_.‘“ v— 2
- . ) { = = . ab|
#. Add Virtual Directory... o T s
st .NET Users Application Connection
Edit Bindings... Settings Strings
| Manage Website » | 2  Restart
) Refresh Start
X Remove @ Stop
Rename @] Browse
(.= Switch to Content View Advanced Settings... -:?):)
Authentic... Compression  Default Directory
Document  Browsing
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Step 3: Select the Default Pools.

Advanced Settings ? -

ID 1
Name Default Web Site
Physical Path %SystemDrive%\inetpub\wwwroot

Physical Path Credentials
Physical Path Credentials Logon ClearText

Start Automatically True
4 Behavior
Enabled Protocols http
P Limits
Application Pool

[applicationPool] Configures this application to run in the specified

application pool.
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Step 4 Disable the OPTIONS method, this can be done by following the path - Server
Manager - Internet Information Services (IIS) Manager - Request Filtering.

Lol
6@ [Ovsawz » Sites » Default WebSite » |m,\ e~
File View Hep
TR 0 Default Web Site Home p— r
Start P, ‘
a8 SSSBWE:O(CSERVE!\A&M Groupby: Area v (3| v 2. Explore
) Applcation Pools 4 Edit Permissions...
=8l a*: - Edit Ste
e Bindings...
[} Basic Settings...
View Applications
View Virtual Directories
IISReports IPv4Address ISAPIFiters  Logging -
and Domai... Manage Web Site Al
b ,_r.ﬁ < Restart
J’P. ! b Start
MIME Types Modules B Stop
Browse Web Site
& S Browse *:80 (http)
SSL Settings Advanced Settings. ..
;' Configure
Falled Request Tradng...
‘ | » - | Features View (.- Content View Limits... =
: 4
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Step 5: In the action pane, select "Deny Verb" - Insert ‘OPTIONS’ in the Verb > OK.

9’ Request Filtering
Use the feature to corfigure fiRerng rules.
2 Fiie Name Extensons | %" Rudes Hadden Segments | O URL 7 HTTPVets & Headers | (D Query Strings
Ved Aloned
Deny Verd i x|
Vet
OPTIONS
oK Concel
Features View | Contert View

Step 6: Enable Dynamic IP Restrictions blocks by going to - IIS Manager - Double click
on "IP Address and Domain Restrictions" > Actions pane.

s ~
' 9 - prp— ¥
’\; CGl { ) 1 iy =
WO = o ik &)
Authentic.., CGl Compression  Default Directory  Error Pages FastCGI Handler
Document  Browsing Settings Mappings

afw]|e & @ » Mo @
% L o P « i
HTTP IP Address | ISAPland  ISAPIFilters Logging MIME Types  Modules Output
Respon... Jand Domainj CGl Restri... Caching
Restrictions 4
2 =" ‘B
e " <% o
Request Server URL Rewrite Worker
Filtering  Certificates Processes
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Step 7: Then select "Edit Dynamic Restriction Settings" - Modify and set the dynamic IP
restriction settings according to your needs > press OK.

[#] Deny IP Address based on the number of concurrent requests

Maximum number of concurrent requests:
b

(¥ Deny IP Address based on the number of requests over a period of time
Maxmum number of requests:
20

Time Period (in milliseconds):
200

[ ] Enable Logging Only Mode

oK l Cancel

Step 8: Enable and Configure Request Filtering Rules, to do this - IIS Manager > Double
click on "Request Filtering" - Change to the Rules tab > Actions Pane.

- 1 . ps
¥ Internet Information Services (IS) Manager

() (O ewwmmmmmy i » Defout WebSee » [ RSl A
file Yiew Help
e | 0 Default Web Site Home e |
Q- kd % & Open Feature
3 e p.ge Group by: Area b —:-? . B Explore
Cntmtoscseccote p— ; y ;
3 Application Pooks r ~r= ] ﬁ - - Edt Permissions..
2.3 Skes Default Directory  Error Pages Failed Handler £dit Site
. Document  Browsi uest Tra.. Mappi
@ Defoult Web Sie " Res . ey Bindings...
@ Foo i g i, 3 a (5 Basic Settings...
e ) L % 7
HTTP HTTP  DSReports IPwd Address ISAPI Filters View Applications
Redirect Respon... and Domai... View Virtual Directories
, . o s Manage Web Site s
n 1]5‘ ‘-*a ’f‘. o Restart
!
logging MIME Types Modules  Output T
Caching >
| Swp
& Browse Web Site
SSL Settings [$) Browse 20 (http)
E Advanced Settings
Management Configure
| 7 %\‘ Failed Request Tracing...
Configurat..  Database R
Editor Manager = || @ Hep
Online Help
‘ m v | [5] Features View . Content View
Ready ]
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Step 9: Then select "Add Filtering Rule" - Set the required rules > Click OK.
Name:
'SQL_Injection_Mitigation ‘

[¥] Scan url

(] Scan query string
Scan Headers
I Header

I

Applies To
' File Extension

-

aspx

*

Deny Strings
| String A
o
drop
update
convert "

o] o
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Step 10: Enable logging, to do this we need to follow this path - IIS Manager > select
the specific site you want to configure > Logging

U}Q Logging

Use thes feature to configure how K5 Sogs requests on the Web server
One log file per
e

w
Log File
Format:

wic Select Fields.
Duectory:

NSystemDrnve Ninetpublogs\Loghibes
Encoding:
UTF-8

Log Event Destination

Select the destination where £S5 will wrte log events.
@) Log file only
ETW event only

Eoth log file and ETW event

Log File Roliover

Sefect the method that IS uies to creste s new log fie
8 Schedule

Dady

Manmum file size (in bytetr

Do not create new log files

Use focel time for fle naenang and tollover

Features View |, Content View
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20. Windows Server 2012 - Hyper-V

Virtualization is one of the most important technology feature and Microsoft has invested
on this and the responsible role is called as Hyper-V.

Let us now see how to install the Hyper-V Role, for doing this we should follow the steps

given below.

Step 1: To Install DNS role go to “Server Manager” - Manage > Add Roles and Features.

| I Manage Tools

| Add Roles and Features
’ \ Remove Roles and Features

Add Servers

Create Server Group

Server Manager Properties

Step 2: Click Next.

Before you begin

Installation Type

Server Selection

DESTINATION SERVER

This wizard helps you install roles, role services, or features. You determine which roles, role services, or
features to install based on the computing needs of your organization, such as sharing documents, or
hosting a website.

To remove roles, role services, or features:
Start the Remove Roles and Features Wizard

Before you continue, verify that the following tasks have been completed:

* The Administrator account has a strong password
* Network settings, such as static IP addresses, are configured
* The most current security updates from Windows Update are installed

If you must verify that any of the preceding prerequisites have been completed, close the wizard,
complete the steps, and then run the wizard again,

To continue, click Next.

[C] Skip this page by default

< Previous i Install
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Step 3: Select the Role-based or feature-based installation option > click Next.

DESTINATION SERViIn

Select installation type

Select the installation type. You can mnstall roles and features on a running physical computer or virtual

SUkve You Bagh machine, or on an offine virtual hard detkc (VHD).

- -based of feature-based installation

Sarver Selection
2 gt ) Configure a single server by adding roles, role services, and features.

Remote Desktop Services installation
Install required rolle services for Virtual Desktop Infrastructure (VOI) to create a virtual machine-based
or session-based desktop deployment.

Step 4: I will install a Local Hyper-V role as it will Select a server from the server pool >
Next.

DESTINATION SERVER

Select destination server

Before You Begin Select a server or a virtual hard disk on which to install roles and features.

Installation Type
5 O Select a virtual hard disk

Server Roles Server Pool
Faaturss

Filter;

Name IP Address Operating System

192.168.0.40 Microsoft Windows Server 2012 Datacenter Evaluation

1 Computer(s) found

This page shows servers that are running Windows Server 2012, and that have been added by using the
Add Servers ¢ d in Server Manager. Offline servers and newly-added servers from which data
collection is still incomplete are not shown.

[<previous || Net> || [ ot [ Concel ]
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Step 5: From the Roles lists, check the Hyper-V Server role - click Add Features on the
popup windows which show up and then > Next.

Select server roles J—

[ 4 The destination server has a pending restart. We recommend that you restart the destination server before either installingo.. X |

Sefore You Begin Select one or mare roles to install on the sefected server.
instatiation Typa Roles Description
S=rver Selection bicd +ovve @O wevIny, ettt oo otame [A]  Hyper-V provides the servces that
_ [ Actve Directory Fedenation Services YOU CaN use tO Create and manage
" Active i p oht i s s I8 virtual machines and their resources.
Features & & oy Rg ? Each virtual maching is @ virtuskeed
3 Acuve Y Rights ? Services computer system that operates m an
] Applcation Server lated execution . This
[] DHCP Server sllows you to run multiple opersting
0] oS . systems simultanecusly.
[ Fax Server
b [H] File and Storage Services (2 of 12 installed)
Netwark Policy and Access Seevices

7] Print and Document Senices
[W] Remote Access (1 of 3 instalied)
[] Remote Desktop Servces

™1 Vnlieme &rtnmban Sandres

l¢

(o] W] [ s | [T

Step 6: Click Next.

SUTNATION SERVER

Hyper-V
Befora 1o Bagn Hyper-V allows you 10 vrtualige your server workdoads by g those workioads on wival h

; You can vse vtual machunes to I, ftiple workicads on one physical server, t0 improve
(PSRN Ty secver pvalablity, and 1o ncraase efficiency in developing and testing software
Server Salector

Things to note:

Server Boles
Feanures * Before you imstall ths role, you should identify which network connections on this server you want 1o

use for settng up virtusl switches.
_ ¢ After you ingtall Hyper-V, you can use Hyper-V Manager to create and configure your virtus!l
VIrtuai Swinches machines.

Migration
Dafault Sores
Confirmatico

More mformation shout Hyper-V
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Step 7: Choose your server's physical network adapters that will take part in the
virtualization > Next.

. . DESTINATION SERVER
Create Virtual Switches e
Before You Begin Virtual machines requ.ine virtual switches to communicate with other computers. After you install this
role, you can create virtual machines and attach them to a virtual switch.
Instaliation Type
; One virtual switch will be created for each network adapter you select. We recommend that you create
Server Selection at least one virtual switch now to provide virtual machines with connectivity to a physical network. You
Server Roles can add, remove, and modify your virtual switches later by using the Virtual Switch Manager.
Features
Hyper-V
’v“gfaf'oﬁ
Default Stores
Confirmation (i) We recommend that you reserve one network adapter for remote access to this server, To reserve 3

network adapter, do not select it for use with a virtual switch.

Step 8: Under Migration, leave the default settings > Next.

Virtual Machine Migration —_—

Hyper-V can be configured to send and receive live migrations of virtual machines on this server.

: Configuring Hyper-V now enables any available network on this server to be used for live migrations. If
Instaliation Type you want to dedicate specific networks for live migration, use Hyper-V settings after you install the role.
Server Selection

Before You Begin

[] Allow this server to send and receive live migrations of virtual machines
Server Roles
1~ Authentication protocol

Select the protocol you want to use to authenticate live migrations.

Hyper-V ® Use Credential Securnity Support Provider (CredSSP)
Virtual Switches This protocol is less secure than Kerberos, but does not require you to set up constrained

Features

_ delegation. To perform a live migration, you must be logged on to the source server.
Use Kerberos

Cefault Stores This protocol is more secure but requires you to set up constrained delegation in your

Confirmation environment to perform tasks such as live migration when managing this server remotely.

A 'f this server will be part of a cluster, do not enable migration now. Instead, you will configure the
server for live migration, including specifying networks, when you create the cluster.
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Step 9: Choose the path where to save the file.

Default Stores PESEE—

Befors 'ou 2egin Hyper-V uses default locations 10 store virtual hard disk files and virtual machine configuration files,
unless you specify different iocations when you create the files. You can change these default locations

ingtaliation Type now, of you ¢an change them later by modifying Myper-V settingt.

Server Sziecton

Server Aotes Default location for virtysl hard disk filex

Fastices ChAUsers\Public\Documents\Hypee-V\Virtua! Haed Disks
ypar-V Oetault | for virtual machine configuration files:
Virtual Switchat CA\ProgramData\Microsoft\ Windows\Hyper-V

Migration

Confirmation

Step 10: Click Install and wait for the installation bar to finish.

Confirm installation selections

Before You Segin To install the following roles, role services, or features on selected server, click Install.
Instalistion Type Restart the destination server ically if required

Servar Selection Optional festures (such a5 administration tools) might be displayed on this page because they have

it been selected automatically. If you do not want to install these optional features, click Previous to clear
eEriows theis check boxes.

Features .
Hyper-V Hyper:V.
Virtual Switches R ServerAdmiinEuation Fook:
Role Administration Tools
Hyper-V Management Tools

Migration

Dafault Storae Hyper-V Module for Wind P &b e

Hyper-V GUI Management Tools

Export configuration settings
Specify an alternate source path
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21. Windows Server 2012 - Advanced Configuration

In this chapter, we will see how to create a virtual machine. Firstly, we should open the
Hyper-V manager and then follow the steps given below.

Step 1: Open “Server Manager” - and then Click on “Hyper-V”.

M., SERVERS
i Dashboard OB A sarvers | 1 10ta)
§ Local Server ) .
filer p gl Rv
h All Servers
i@ ADDS Serves Name 1w Address Maragesbity Last Update Window A

'! DHCP m
Add Roles and Features

& DNS
Shut Down Local Server

B§ Fle and Storage Services b

Computer Management
[
o 15 Windows PowerShel
Configure NK Teaming
Contigure Windows Automatic Feedback
| | Hyper-¥ Marager ||
EVENTS Mansoe A
audoeed Ul Stant Performance Counters
Filter F o

Copy

Secves Name 10 Severity Scorce log
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Step 2: Click "New” on the Right side Panel or click on Action button in the options as
shown in the screenshot below.

e 2

| B

&3 Hyper-V Manager

%] Hyper-V Settings...

g% Edit Disk...

{5 inspect Disk...
(®) Stop Service
75 Remove Server

(3 Refresh

View

H Hep

I3 Virtual Switch Manager...
| . Virtual SAN Manager...

Step 3: Double Click on the Virtual Machine option as shown in the following screenshot.

L

New

»

aH
-l

Import Virtual Machine...
Hyper-V Settings...
Virtual Switch Manager...
Virtual SAN Manager...

| Edit Disk...
Inspect Disk...

Stop Service

' Remove Server
Refresh

File‘kﬁonl\ﬁew Help

Virtual Machine...

Hard Disl

| Floppy Disk...

-~

State
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Step 4: A new table will be open > Type the Name of your new machine and then click
Next.

Choose a name and location for this virtual machine,
‘mennecdshvedhnwer-vw We recommend that you use 3 name that helps you easly

identify this virtual machine, such as the name of the guest operating system or workdoad.
Name:  |Windows 7| |

You can create 3 folder or use an existing folder to store the virtual machine. If you don't select a
folder, the virtual machine s stored in the default folder configured for thvs server,

[] Store the virtual machine in a different location
Locabor | C:\ProgramDataMcrosoft\Windoves ¥Hyper V)

MAaCHINg, et

Step 5: A new table will be open where you must allocate the memory. Keep in mind that
you cannot choose more memory than what you have in your system.

Specify the amount of memory to allocate to this virtual machine. You can spedfy an amount from 8
MB through 5816 MB To improve performance, specify more than the minimum amount recommended
tem,

;2w

Assign Memory

Configure Networking
} Use Dynamic Memory for this virtual machine.
Connect Virtual Hard Disk
A : When you decide how much memory to assign to a virtual machine, consider how you intend to
Instalation Options 0 use the virtual machine and the operating system that it will run.
Summary

Step 6: In the Connection dropdown box, choose you physical network adaptor and click
Next.
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Step 7: Now it is time to Create a Virtual Hard disk. If you already have one, choose the
second option

A virtual machine requires storage so that you can install an operating system, You can specify the
storage now or configure it later by modifying the virtual machine’s properties.

(®) Create a virtual hard disk
Use this option to create a dynamically expanding virtual hard disk with the default format (VHDX).

Name: |Windows 7.vhdx |
Location: |C: \Users\Public\Documents \Hyper-V\Virtual Hard Disks\ || Browse... |

Size: GB (Maximum: 64 TB)

() Use an existing virtual hard disk
Use this option to attach an existing virtual hard disk, either VHD or VHDX format.

Location: fC:V.Jses\PubBcDowtsHyper-v\wmd Hard Disks\ | Browse...

O Attach a virtual hard disk later
Use this option to skip this step now and attach an existing virtual hard disk later.

<Previous | [ Next> J cancel |
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Step 8: Select the Image of ISO that should be installed and then click Finish.

Before You Begin
Specify Name and Location
Assign Memory

Configure Networking
Connect Virtual Hard Disk

\’.‘. ’
m Installation Options

You can install an operating system now if you have access to the setup media, or you can install it

later.

() Install an operating system later

(® Install an operating system from a boot CD/DVD-ROM

Media

O physical CODWD drive: [D: |
(® Image file (iso): |C:\sers\Administrator\Desktop\Windows7 x86.i¢| | Browse...

O Install an operating system from a boot floppy disk

i
Media

Virtua! floppy disk (vid): [ | | Browse,,
!

(O Install an operating system from a network-based installation server

<Prevous | | Next> ||| Fsh || concel

Before You Begin

Spedify Name and Location

Assign Memory

Configure Networking

Connect Virtual Hard Disk
Installation Options

Summary

Completing the New Virtual Machine Wizard

You have successfully completed the New Virtual Machine Wizard. You are about to create the
virtual machine.

following
Description:
Name: Windows 7
Memory: 2048 MB
Network: Intel(R) PRO/1000 MT Network Connection - Virtual Switch
Hard Disk: C:\Users'\Public\Documents\Hyper-V\Virtual Hard Disks\Windows 7.vhdx (VHDX, ¢

Operating System: Wil be installed from C:\Users\Administrator \Desktop\Windows7 x86.iso

Ta te the virh al machi i dncs the wizard_dick Einick
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Step 9: Connect to the Virtual machine. To do so, Right Click on the machine name and

then = Connect.

]
Virtual Machines
' Name State CPU Usage Assigned Memory  Uptime .
;
Connect...
; Settings...
| <
— Start ‘
| Snapshots Snapshot |
Move... as no snapshots.
Export...
Dnn:mn

Step 10: After that, the Installation of your ISO will continue.

File Action Media Clipboard View Help

G O0O@O@O I b Bs

% Install Windows

'.

Windows 7

LangusqJERRIE ol -

Time and currency format: English (United States)

Keyboard or input method:

EIMPLYEAEYLEARMNINEG
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22. Windows Server 2012 - Configure WSUS Role

As you know the WSUS (Windows Server Update Services) is an update service of Microsoft
which allows the companies to test updates before installing to live environment.

To install this role, we should follow the steps given below.

Step 1: Go to “Server Manager” > Manage > Add Roles and Feature - Next - Select
“Role-based or feature-Based-Installation - Select a server from the pool server and then
- Next.

DESTINATION SERVER

Select destination server —

Before You Begin Select a server or a virtual hard disk on which to install roles and features.

Installation Type (®) Select a server from the server pool
) Select a virtual hard disk

Server Roles Server Pool
Features
Filter:
Name IP Address Cperating System

Microsoft Windows Server 2012 R2 Standard

1 Computer(s) found

This page shows servers that are running Windows Server 2012, and that have been added by using the
Add Servers command in Server Manager. Offline servers and newly-added servers from which data
collection is still incomplete are not shown.

S| [ | o]
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Step 2: Check “Windows Server Update Service” a pop-up window table will come out >
click “"Add Features” then > Next and then again > Next.

Select server roles

DESTINATION SERVER
=,

I A The destination server has a pending restart. We recommend that you restart the destination server before either installing 0... X

Before You Begin
installation Type

Server Selection

Features

Select one or more roles to install on the selected server,

Roles

[[] DHCP Server
[C] DNS Server
[[] Fax Server
b [m] File and Storage Services (2 of 12 installed)
[C] Hyper-v
[] Network Policy and Access Services
[] Print and Document Services
b [®] Remote Access (1 of 3 installed)
[[] Remote Desktop Services
[T] Volume Activation Services
[[] Web Server (IIS)
[J Windows Deployment Services
[] Windows Server Essentials Experience
rE] Windows Server Update Services

]

Description

Active Directory Certificate Services
(AD CS) is used to create
certification authorities and related
role services that allow you to issue
and manage certificates used in 2
variety of applications.

install | [ Cancel |

Add features that are required for Hyper-V?

The following tools are required to manage this feature, but do not
have to be installed on the same server.

4 Remote Server Administration Tools
4 Role Administration Tools

4 Hyper-V Management Tools

[Tools] Hyper-V Module for Windows PowerShell

[Tools] Hyper-V GUI Management Tools

Include management tools (if applicable)

Add Features
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Step 3: Check box of WID Database and WSUS Services

Select role services

8efore You Begin

Instaliation Type Role services

Server Selection
| i
rver Rol = .
Server Roles (@) WSUS Services
Features ~

wSsuUs

Content

Windows Server 2012

Select the role services to install for Windows Server Update Services

DESTINATION SERVER
ja=——]
Descriot
] Installs the database used by WSUS
into WID.
—
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Step 4: Choose the path for the content. If you have another partition other than C:, then
install it there because C: can risk to become full > Next.

Content location selection

Before You Begin
Instaliation Type
Server Selection
Server Roles

Features
WSUsS

Role Services

web Server Role (IIS)
Role Sarvices

Confirmation

If you have a drive formatted with NTFS and at least 6 GB of free disk space, you can use it to store
updates for client computers to download quickly.

If you need to save disk space, clear the check box to store updates on Microsoft Update;

downloads will be slower.

If you choose to store updates locally, updates are not downloaded to your WSUS server until you
approve them. By default, when updates are approved, they are downloaded for all languages.

[ViStore updates in the following location (choose a valid local path on CEEEEEERESSEEEN, o 2

remote path) :

. T

FE [
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23. Windows Server 2012 —WSUS Policies & Tuning

In this chapter, we will see how to configure WSUS and tune it. The following steps should
be followed for configuring it.

Step 1: When you open it for the first time, you should do it by going to “"Server Manager”
- Tools > Windows Server Update Services, then a Configuration wizard will be opened
and then click > Next.

% Connect to Upstream Server
Download update information from Microsoft Update
Before You Begin To configure Windows Server Update Services on the following screens, we need to apply
Microsoft Update your upstream server and proxy server settings and synchronize information about available
Improvement Program updates.
: > f Information to be downloaded includes:
Specify Proxy Server
Choose Languages Types of updates available
Choose Products Products that can be updated
Choose Classifications SRS My
Configure Sync Schedule Click Start Connecting to save and download upstream server and proxy server information.
Finished This process might take several minutes or longer, depending on your connection speed.
What's Next
[ <Bock || Nea> |
——
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Step 2: Click “Start Connecting” > Wait until the green bar is full and then > Next.

ﬁ Connect to Upstream Server
Download update information from Microsoft Update

Before You Begin To configure Windows Server Update Services on the following screens, we need to apply
Microsoft Update your upstream server and proxy server settings and synchronize information about available
Improvement Program updates.

Cho?seUpst:umSuva Inf 2o b0 be downloaded Inckid

Specify Proxy Server

Choose Languages Types of updates available

Choose Products :roducts that can be updated

Choose Classifications i gusg

Configure Sync Schedule Click Start Connecting to save and download upstream server and proxy server information.
Finished This process might take several minutes or longer, depending on your connection speed.
What's Next

Start Connecting Stop Connecting I

< Back Next > Finish Cancel

ﬁ Connect to Upstream Server
Download update information from Microsoft Update

Before You Begin To configure Windows Server Update Services on the following screens, we need to apply
Microsoft Update your upstream server and proxy server settings and synchronize information about available
Improvement Program updates.

Choces DS S lnformation 1 be downlosded inchades

Specify Proxy Server

Choose Languages Types of updates available

Choose Products Products that can be updated

ct Classificati Available languages

Configure Sync Schedule Click Start Connecting to save and download upstream server and proxy server information,
Finished This process might take several minutes or longer, depending on your connection speed.
What's Next

\ Start Connecting | Stop Connecting

| <Back || Nea> ]\ Finish | [ Cancel |
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Step 3: Check the box for which the updates want to be taken, I did for English and then
- Next.

E Choose Languages
Select the languages for which this server will download updates

Before You Begin If you are storing update files locally, you can filter the updates downloaded to your
Microsoft Update server by language. Choosing individual languages will affect which computers can be
Improvement Program updated on this server and any downstream servers.

Choose Upstream Server

Spucky Brcky Sesye O Download updates in all languages, including new languages
Choose Classifications [] Arabic [] French [] Norwegian
Configure Sync Schedule (] Bulgarian (] German (] Polish
Finished [[] Chinese (Hong Kong SAR) (] Greek [7] Portuguese
What's Next [7] Chinese (Simplified) [7] Hebrew [7] Portuguese
[7] Chinese (Traditional) [7] Hindi ["] Romanian
[7] Croatian [7] Hungarian [7] Russian
[[] Czech [T] atian [T] Serbian (Lati
[T] Danish [7] Japanese [[] Stovak
"] Dutch [T] Japanese (NEC) [T] Slovenian
(] Korean [] Spanish
|| Estomian [7] Latvian [T] Swedish
[7] Finnish [7] Lithuanian [7] Thai
<] L | >
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Step 4: Check the box for all the products which you want to update. It is just for Microsoft
products and it is recommended to include all the products related to Microsoft and then
- Next.

Choose Products
Select the Microscft peoducts to be updated
Before You Begin 51 You can speciy the products for which you want updates.
Microsoft Update i"
Iimpeovement Program
Choose Upstream Server Products
s s [(IWindows & Language Interface Packs ~
P [(Iwindows & Language Packs
o
M (| Windows 8.1 Preview Dynamic Update
Choose Classifications
Cov.ﬁgnS)mSMk Preview Dynamic Update
Fanished [[IWandows Defender
What's Next [CIWindows Dictionary Updates
[IWindows Embedded Standard 7
[CIwindows | Explorer 7 Dynamic Install
[IWindows Internet Explores  Dynamic Installer &
[CIWindows Media Dynamic installer
[IWindows RT v
(<[ ™ > J
All products, inchuding products that are added in the future.
Ty (R

Step 5: Choose the classification updated to be downloaded, if you have a very good
internet speed, then check all the boxes, otherwise just check “Critical Updates”.

E Choose Classifications
Select the update classifications you want to download

Before You Begin : You can specify what classification of updates you want to synchronize.
Microsoft Update
Improvement Program e
ct U S Clasnﬁcoh?ns '
cine R
Choose Languages
¢ P D 5 intion €5
| Choose Classifications | ClF et Picks
Configure Sync Schedule [JSecurity Updates
Finished [TIService Packs
What's Next [Tools

[Jupdate Rollups

[TJUpdates

A broadly released fix for a specific problem addressing a critical, non-security related
bug.
< Back Nexdt > Il Finish ]
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Step 6: Now we should schedule the updates which I will recommend to do it automatically
during night time > Next.

Set Sync Schedule
Configure when this server synchronizes with Microsoft Update

Before You Begin ﬂ You can synchronize updates manually or set 3 schedule for daily automatic
Microsoft Update @ synchroniation.
Improvement Program
Choose Upstream Server
Specify Proxy Server
Choose Languages
Choose Products — —
Choose Classifications First synchronization: I &57:17 PM v
Srreeihens Synchronizations per day; | ¥
Finished
: Note that when scheauling 3 dally syncnronization from Microsornt Update, the
What's Next synchronization start time will have a random offset up to 30 minutes after the specified

bime

e T
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Step 7: Check Box “Begin initial synchronization” - Finish.

% Finished
Finished initial configuration of your server

Before You Begin @ You have now finished configuring your WSUS server. You can go on to launch the WSUS

Microsoft Update Administration Console or start the initial synchronization.

Improvement Program

w:‘ | Launch the Windows Server Update Services Administration Console

pachy Py Get started administering your organization by starting the Windows Server Update

Choose Languages Services Administration Console

Choose Products

Choose Classifications Begin initial synchronization

Configure Sync Schedule The initial synchronization with Microsoft Update or your upstream server can take

J some time. The length of the initial synchronization depends on the number of

What's Next products, update classifications, and languages you have selected, as well as the speed
of your Internet connection.

Cae e
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Step 8: Now the WSUS console will be open and we must add the computer to WSUS. To
do this, go to Options > Computers.

Options.

|| 5 search..

View »

Options New Window from Here
Update Source and Proxy Server G Refresh

You can choose whether this Windows Server Update Services server synchronizes from Microsoft Help
Update or from an upstream Windows Server Update Services server on your network. g

.g-] This view allows you to configure settings on your server.

Products and Classifications
You can specify the products for which you want updates and the types of updates you want.

Update Files and Languages L]
You can choose whether to download update files, where to store downloaded files, and which
update languages you want to download,

| QL

Synchronization Schedule
You can choose to synch ily or set a schedule for daily ic synch

L

Automatic Approvals
You can specify how to ly app
o approve revisions to existing updates.

sﬁl

of updates for selected groups and how

Computers
You can specify how to assign computers to groups.

Server Cleanup Wizard
You can use server cleanup to free up old computers, updates and update files from your server.

Reporting Rollup
You can choose to have replica downstream servers roll up update and computer status.

L 4% ¢| %

E-Mail Notifications
You can have Windows Server Update Services send e-mail notifications of new updates and status
reports. v
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Step 9: If you have a Domain Controler environment, choose the second option like in my
case, otherwise choose the first option and then > OK.

General

# You can specify how to assign computers to groups.

() Use the Update Services console

Note: New computers will automatically be placed in the Unassigned
Computers group.

@ Use Group Policy or registry settings on computers.

141

' tutorialspoint

EIMPLYEAEYLEARRMINEG



Windows Server 2012

Step 10: After you have done all this, you should approve updates, which is similar like
how it is done in the previous version. To do this — Right click on the updates - Approve
as shown in the screenshot given below.

[& Tie Action View Window Hep L
e« 2 B
|5 Update Services
-+
a { Updates
4 & Al Computen Update for internet Explores Flas < red O% Not approved G PRefresh
& Unassigned Comi | Update for interet Explores Flas i ed . 0% Mot approved B v
3 ©F Combystembapti| |\ e for intemet Explocer Flas. | RviSI0R History ) 0% Not approved !
- o Update for Intemet Explores Flyg ¢ Informatic XKBL. 0% Netappeoved |update |
B Repoats Update for Intermet Explorer Flas Status Repont wed .. ON Notapproved fo Aeprove.
i) Optioes Update for Intomet Explores Flas ~ Help 2. O% Netapproved  Dechne
Update for Windows § for xfd-based Systerms (KBI312822) 0% Not spproved 2, Geoup By
Update for Intemet Explorer Flash Player for Windows § (KB2205580) 0% Not approved € Revwon Hatory
Update for internet Explorer Flash Player for Windows Server 2012 (XB2.. O Not approved ¥ Fieinformation
Update for internet Explorer Flash Player for Windows Server 2012 (XB2.. O% Not approved B Status Repon
Update for Windows § for xbi-bated Systems (XB103748) O% Not spproved ﬂ Help
Update for Windows & (KB2303748) ON Not approved v
Update foe Windows 8 (XB2212822)
(1) Tha update s wpereded by ancther update. Befoce you deciine amy superseded update, we dthat ~
you verfy t 15 ne longer needed by arry computers. To do 10, sppeove the superseding update first.
Status: MSRC severity: Unspecified o
B Computers with erroes MSRC number: None
Computers needing tha update
Eonvwm mlatied nct spphcadie Release date: W Mool
Computers with no status KB article numbers: 2812822
Description
<l = 11 lnsta tha wodate to resolve aswes m Windows. For 8 comalete lntno of the isues that ace included in tha -

Iﬁl
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Step 11: Then you should click Approve for install as shown in the screenshot given

below.

Critical Updates (95 updates of 97 shown, 97 total)

Approval:  Any Except Declined ~ Status: [Any

|| G Refresh

Installe... Approval

¢ for Windows 8 (KB2751352)

0% Declined

To approve an update, select the group from this list of groups, click the arrow, and choose the type

of approval.
Computer Group Approval Deadline
Q | All Computers Not approved N/A
N/A (inherited 8 Approve.
Not approved (inherited) N/A (inhented) 55 Decline
=, Group By
Approved for Removal Ctrl+R € Revision |
Not Approved Ctri+N [# File Inforr
Deadline B StatusRe|
Same as Parent Help
Apply to Children
Status: MSRC severity: Unspecified =
B Computers with errors: MSRC number: None
Computers needing this update: .
Computers installed/not applicable: Release date: ;‘lo?‘;ﬂ&dly. March 13,
Computers with no status: 0 .
KB article numbers: 2812822
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24. Windows Server 2012 - Sharing of Files

Another important service for Windows Server is Sharing Files and for this purpose the
Windows Server 2012 has - File and Storage Services, which is found in Server Manager
on the left pane as shown in the screenshot given below.

@ v Server Manager * All Servers

= = SERVERS
IB2 Dashboard B servers | 1 total

i Local Server

on \
= Filter Jeol @B @~
BE All Servers

W§ File and Storage Services P Server Name IPv4 Address Manageability

il Remote A
2l Remote Access " 17 Online - Restart pending

Now let us see how to create a Share in the system with its respective rights. To do this,
we should follow the steps given below.

Step 1: Click Server Manager - then click on File and Storage Services in the Server
Manager sidebar > click on Shares - click on the Shares drop-down list &> click on New
Share.

1025 Used B 108 G3 Uses Space
=] 585/G2 Froe Space
Go %o Volumet Overveen »

QUCTA

—t -

erver By Monager v

T3 wmetoll 7 Sevver Besource Namoger, 1o ¢ Add Rzie ot Fetres o2
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Step 2: This will open the New Share Wizard - From here, select a type of share > I will
create a very basic SMB share, so click on SMB Share — Quick. We can later configure the user

rights of this share.

File sh file: Description:
This basic profile represents the fastest way to create an

h ; | SMB Share - Quick
nare:Lacation SHIB Share - Advanced SMB file share, typically used to share files with
Share Name o Windows-based computers,
SMB Share - Applications
NFS Share - Quick * Suitable for general file sharing
* Advanced options can be configured later by

NFS Share - Advanced
using the Properties dialog

[<prevous |[CNea> ]| [“creme | [cance
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Step 3: Click "Type a custom path” - click on Browse button.

Windows Server 2012

Select the server and path for this share

Select Profile Server:
Share Location Server Name Status Cluster Role
. 4 Online Not Clustered

Share location:
() Select by volume:
Volume

€ 889GB 99.7GB NTFS

The location of the file share will be a new folder in the \Shares directory on the selected

volume.

(® Type a custom path:

Free Space Capacity File System

Owner Node

Create

|Cance|

New Folder Delete
4 & G | ] share
b e (C)

Folder: Ci\users\Administrator\desktop\share

Select Foider ||| Cancel |
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Step 5: Click Next.

Specify share name

Sslect Frofile Share name: share
Shara Location

T

Other Settings

Local path to share:
ClusersiAdmmistrator'deskiop\share

Remaote path 10 shace
| e

e e [ o

Step 6: You can choose one of the three options as per your need. The explanations are
also mentioned alongside the check boxes, once selected -> Next.

Configure share settings

Select Profile [} Enable access-based enumeration
Sharsbocation Access-based enumeration displays only the files and folders that a user has permissions to

|re Locaten access. If a user does not have Read (or equivalent) permissions for a folder, Windows hides the
Share Name folder from the user's view.

[v] Allow caching of share

Permissions Caching makes the contents of the share available to offline users. If the BranchCache for
Network Files role service is installed, you can enable BranchCache on the share.
[_] Enable BranchCache on the file share

BranchCache enables computers in a branch office to cache files downloaded from this
share, and then allows the files to be securely available to other computers in the branch.
[[] Encrypt data access

When enabled, remote file access to this share will be encrypted. This secures the data against
unauthorized access while the data is transferred to and from the share. If this box is checked
and grayed out, an administrator has turned on encryption for the entire server.

<Prev;ous” Next > ] [ Create | Cancel
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Step 7: Click on Customize Permissions to authorize the rights that your users need to
have.

Specify permissions to control access

Select Profile Permissions to access the files on a share are set using a combination of folder permissions, share
Share Location permissions, and, optionally, a central access policy.

Share Name Share permissions: Everyone Read Only

Other Settings Folder permissions:

T Access Applies To

Confirmation ministrator _Full Control _ This folder, subfolders, and files i
Allow BUILTIN\Administrators Full Control  This folder, subfolders, and files
Allow NT AUTHORITY\SYSTEM Full Control  This folder, subfolders, and files

|| Customize permissions... II

I<vaiousl| Next > | ‘ Create || Cancel

Step 8: Click on Add if you would like to add other users.

I Permissions | Share I Auditing Itﬁxﬁwﬁantl

For additional information, double-click a permission entry. To modify 3 permission entry, select the entry and click Edit (if available).

Permission entries:

Type Principel Access inherited from Apphes to
R Allow  SYSTEM Full control Chusers\Administrator\  This folder, subfolders and files
B Allow  Administrators (MEEEEEERSR..  Full control Cusers\Adminestrator\  Ths folder, subfolders and files
2 Allow  Administrator (SEEEEEEESR0..  Full control Ciusers\Admunistrator\  This folder, subfolders and files

|I Add I[m]ﬁvw]

[ 7] Replace all child obgect permission entries with inheritable permission entries from this abject

| ok || Cancet ]: Apply
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Step 9: Click on Select a principal.

Principal}  Select a principal

Type: Ai{ow

Applies to: | This folder, subfolders and files v/

Basic permissions:

Show advanced permissions

| Full control
["IModify

v Read & execute
[V List folder contents
Wi Read

" Write

"] Special permissions

{1 Only apply these permissions to objects and/or containers within this container | Clearall \

%

Step 10: We should give rights that can be done by entering the object name, which is
Backup Operator in this case and then > OK.

Select this object type:
User, Group, or Built-in security principal Object Types...
From this location:
S 06 Locations...
Enter the object name to select [ezamples):
| S \6 ackup Operators| Check Names
Advanced, I 0K || Cancel
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Step 11: To this user we will give Read\Write rights, for that we will check the
respective boxes and then > OK - OK - Next.

Prncpat Backup Openstor; (AMEMRRENARES B >ckup Openatars)  Select 5 prncpal

Type: lNlo* V]

Appies tor | This folder, sublolders and files v|

Basic permussons) Shuw advanced pesmutsians
[ Full control
[ Modify
Iy Read & executa
(W List folder comtents
v Read
Wit

Zoeciyl permurtioey

[_1Only spply these permassions to objects and/or contaimess within this contamer KE

Step 12: Click on Create.

Confirm selections

Select Profile Confirm that the following are the correct settings, and then click Create.
Share Location SHARE LOCATION
Share Name Server: S 05
Other Settings Cluster role: Not Clustered
Permissions Local path: Ci\users\Administrator\desktop\share
SHARE PROPERTIES
Share name: share
Protocol: SMB
Access-based enumeration: Disabled
Caching: Enabled
BranchCache: Disabled
Encrypt data: Disabled

|<vanous|| Next > I I Create Cancel
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25. Windows Server 2012 - File Manager

Like its previous versions, the present Windows Server 2012 version has a File Server
Resource Manager Role. As you know, this is a role that helps system administrators to
manage shared folders in the features link in setting up limits or file extension restrictions.
To install it, we should follow the steps given below.

Step 1: Go to Server Manager - Manage > Add Roles and Features - Next - Check on
the Role-based or feature-based installation box - Check on the Select a server
from the server pool box > Next.

Then, at the list of the roles find File and Storage Services and expand it. After this,
expand the Files and iSCSI Services > Check on the File Server Resource Manager
box and then a pop-up window will open.

DESTINATION SERVER
fo=———=]

Select server roles

Select one or more roles to install on the selected server,

Before You Begn
nsaiation Type Roles Description
Server Seleclion — . - - ~ File Server Resource Manager helps
T el
(] DHCP Server files and folders on a file server by
Faanures e scheduling file management tatks
‘: ONS Serves and storage reports, classdying files
] Fax Server and folders, configunng folder
4 ™ A ye Services (installe quotas, and defining fle screening
4[] File and 5CS! Services . POt
] File Server
] BranchCache for Network Files
[] Data Dedupiication
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Step 2: Click on Add features and then > Next.

Windows Server 2012

Add features that are required for File Server Resource
Manager?

You cannot install File Server Resource Manager unless the following

role services or features are also installed.

|4 File And Storage Services
4 File and iSCS! Services
File Server
4 Remote Server Administration Tools
4 Role Administration Tools
4 File Services Tools

[¥] Include management tools (if applicable)

[Tools] File Server Resource Manager Tools

Step 3: Click the Next button.

OESTMATON SEavEr
Select features —
Bafore You Begin Select one or more features to nstall on the selected server.
Insaiynon .)” Features w
Server Selection l' )l Ta]  NET Framework 3.5 combines the
Server Roles — . power of the NET Framework 20
P8 NET Framework 45 Festures imitafed) APls with new e for
B | oo Soncems  [B]  boking spphcatons et ot
Confirmation b appealing user interfaces, protect
< [[] Bittocker Drive Encryption S :
[ Bittocker Network Uniock niormation enable seamless and
[7] BeanchCache secure communabon, and provide
[7] Chient for NFS the ability to model a range of
(] Data Center Bridging business processes.
[] Enhances Storage
[C] Faflover Oustenng
[[] Group Pobcy Management
[J nk and Handwniting Services
] internet Printing Client
[C] ® Address Management (IPAM) Server
{([ o . J °
= e e
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Step 4: Click the Install button.

< - o ¢ DESTINATION SERVER
Confirm installation selections —

Before You Begin To mstall the following roles, role services, or features on selected server, click Install.

Ingzaliation Type [T] Restart the destination server automatically if required

Server Selection Optional features (such as administration tools) might be displayed on this page becsuse they have

o been selected automatically. if you do not want to install these optional features, click Previous to clear
AR NOyeS their check boxes.

Features :
RN s
File and 1SCSI Services
File Server

File Server Resource Manager

Remote Server Administration Tools
Role Administration Tools
File Services Tools
File Server Resource Manager Tools

Export configuration settings
Specify an alternate source path
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Now that we installed the File Server Resource Manager, let us open it by following the

path given below.

Step 1: Click on Server Manager > Tools > File Server Resource Manager.

erver Manager * Dashboard

#§ File and Storage Services b

WHATS KEW

EEARN MORE

ROLES AND SERVER GROUPS

== File and Storage
Services
@ Manageability

Fyenie

WELCOME TO SERVER MANAGER

Local Server

@ Manageability

Fuents

D

Manage  Took View
Component Sennces
Computer Management
Defragment and Optimize Drives
Event Viewer

Help

File Server Resource Manager
SCS Inibator

Local Security Policy

COZC Data Sources (32-b#)
COEC Data Sources (64-ba)
Performance Monstor
Resource Mon#ar

Security Configuration Wizard
Senvices

System Configuration

System Infoemation

Task Schaduler

Windows Firenall with Advanced Secunty
Windows Memory Diagnostic
Windows PowerShall
Windows PowarShall [x86)
Windows PowerSheil 5E
Wancows PowearShail SE (286)
Windows Server Backup

To set quota to a folder, we should follow the steps as below.

Step 2: On the left panel click on Quota Management > expand Quota Templates >
click on Create Quota Template... on the right-hand side panel as shown in the
screenshot given below.

EAEYLEARMNINEG

'&j Mtutorialspoint

'in Fie Senves Pasoorre Massger (Lecal Queta Templite Lint Quata Type Descrghien Ekﬁn
Py § 1008 Lt ROE bart |0m1 .
§ Qs 2 % ) '
3 Cueta Templates 3 LONGLma Reports o Ve XM Fad | & Coate Quota Tempie.
b & HeXreesns Monagen B 2M8UmtwthOMEEdmics  MOME Ward % Pehesh
B Soogelgotlngenet 13 2015 e o rt - )
b & Chusiicunen Maragemest R = = S
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Step 3: A new table will be opened, where the most important aspect to put is Space
Limit depending on the need. Here, we will put 2GB and then > OK.

|lee_ ]

(®) Hard quota: Do not allow users to exceed limit
() Soft quota: Alow users to exceed limit {use for monitoring)

Notification thresholds
Threshold EventLog Command  Report

155

' tutorialspoint

EIMPLYEAEYLEARRMINEG



Windows Server 2012

Step 4: You must put the threshold for it and once the folder reaches the capacity, it will
send you a notification where you will have an option to put the email.

Generate notfications when usage reaches (%)

Evmad Message | Event Log | Command | Repot |

[7] Send emad to the user who exceeded the threshold

Email message

Type the teat 1o wee for the Subject ine and message

To wdartdy the quota, v, ussges o¢ other Infommation about the cumert threshald, you
can use ingent Variadie to insert & vanabie in yourtaxt

Subject
[ ae T .

|iGQuota Threshold]’ quota threshold exceeded
Message body

iwxmwwwwmmawnmawm -
{the quota on [Guata Path] on server [Server] The quota mit is [Guota Limt MBI MB,
inMMBIHBMnnmeMaMPmI‘LdM)

Selact vanable to insent

\[Mm Emad] vi|  inset Vanabie

rerts the o mal addresees of the admmatratony who receve the empd

Additionial Enal Headers

Il oK ||[°-'°-'I
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Step 5: Click Ok.

l IGB vI

®) Hard quota: Do not allow users to exceed imt
O Soft quota: Allow users to exceed im {use for monoring)

Eventlog Command  Repodt
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Step 6: Then to attach this quota to a folder - Right Click on the template = click on
Create Quota from Template...

FlleActnon View HHdp
o9 2(m Bm

&3 File Server Resource Manager (Local) | Quota Template | Limit | Quotd
«® o pian 3] 100 M8 Limit 100 M8 Hard

L8 otas T T T L T T vl

] Quota Templates S| 200MB Limit Reports to User 200 MB Hard

b 7 File Screening Management 3] 200 MB Limit with 50 MB Exte... 200 MB Hard
B Storage Reports Management || 3 550 g Extended Limit 250 M8 Hard

b »d Cbsstﬁuhoanogemem R T e T o — B rrRty A
a FileM  Tasks 3] Monitor 200 GB Volume Usage 200 GB Soft

3] Monitor 500 MB Share 500 MB Soft

Edit Template Properties..,
Delete
Help

Step 7: Click on Browse... and then select your folder > Create.

Quota path:
[C:\Sham H Browse...

e quota on path
(O Auto apply template and create quotas on existing and new subfolders
Quota properties

You can either use properties from a quota template or define custom
quota properties.

How do you want to configure quota properties?
(® Derive properties from this quota template (recommended):
| 2GB v]

(O Define custom quota properties

I Custom Properties l

Summary of quota properties:
= Quota: C:\Shares

. Limit: 200 GB (Hard)
= Notification: 4
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Step 8: To put a file restriction to your folders, you can go to the left pane File Screening
Management > File screening templates > Click on the left panel Create File Screen

Template...

Fle Action View Hep
LD 1G)

b Fle Serves Pescurce Mamager (Leca)
» & Quots Management
4 g Fle Screening Management
£ Fle Screens
2 Fle Screen Templates
o, Fie Groups
SWRMW
3 4 Classificaton Management
& Fie Management Tosks

Create File Screen from Template...
Edt Template Properties..

X Deete

Help

Step 9: Click on Browse... and find the folder that you want > Create.

File screen properties

You can either use properties from a file screen template or define custom
file screen properties.

How do you want to configure file screen properties?
(® Derive properties from this file screen template (recommended):
| Block Image Files v/

O Define custom file screen properties:

[ Custom Properties ]
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26. Windows Server 2012 — Print Server

In this chapter, we will see how to install a Print Server which plays some very important
roles for the system administrator and the management. We should follow the steps given
below.

Step 1: Go to Server Manager > Manage - Add Roles and Features - Next - Check on
the Role-based or feature-based installation box and > Check on Select a server
from the server pool and then > Next.

Once it is done then, at the list of the roles find Print and Document Services > A pop-
up window will open.

DESTINATION SERVE
Select server roles ot doassad

Select one or more roles 1o install on the selected server.

Before You Begn
Instaliztion Type Roles Description

Server Selection

Print and Document Services

>

™
Active Direct ficate Senvic 12
e vt & [ v s
- L] Active Dwrectory Domain Services and k ponter management

Features [[] Active Drectory Federation Services tasks. With this role, you can also

™1 Active Direc! twesght i Servic receve scanned documents from

g = R i = network scanners and route the

L] Active Directory Rights Management Services documents 1o 3 shared network

] Application Server resource. Windows SharePont

] DHCP Server B|  Services site or e-mad addresses

] DNS Server

] Fax Server

W P8 ANO SI00300 e % (Instaled

[ Hyper-v

["] Network Policy and Access Services |
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Windows Server 2012

Step 2: Click on Add features and then > Next > Next > Next.

Add features that are required for Print and Document
Services?

The following tools are required to manage this feature, but do not
have to be installed on the same server.

4 Remote Server Administration Tools
4 Role Adminstration Tools
[Tools] Print and Document Services Tools

[V Include management tools (if applicable)

|Mdfutnns| Cancel

Step 3: Check on the Print Server box and - Next.

4

3
; DESTINATION SERVER
Select role services e
Before You Begin Select the role services to install for Print and Document Services
Instaliation Type Role services Description
Server Selection — - . Print S includes the Print
Server Roles l .@_ J Management snap-in, which s used
L] Distnbuted Scan Server for managing muftiple priters or
Features ] Internet Printing print servers and migrating printers
Print 3nd Dotumant Servi.. [ LPD Service to and from other Windows print
| ok servces | o
Confirmadion
R I
161
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Step 4: Click Install.

. . . DESTINATION SERVER
Confirm installation selections =
Before You Begin To install the following roles, role services, or features on selected server, click Install.
Instatiation Type [C] Restart the d tion server automatically if required
Server Selection Optional features (such as administration tools) might be displayed on this page because they have
E——— been selected automatically. if you do not want to install these optional features, click Previous to clear
il their check boxes.
Features
Print and Document Servi..| | Print and Document Services
Print Server
Role Services .
Remote Server Adminstration Tools
Role Administration Tools
Print and Document Services Tools
Export configuration settings
Specfy an alternate source path
Net>_| Conce
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27. Windows Server 2012 - Easy Printing

Easy Printing is a feature which allows the client that connects via RDS to print over the
network. It is installed in Windows server 2012 by default. Easy Printing is basically where
the printer device is defined on the client system and a printer is connected directly via
the network. All configuration is done via Group Policy Objects.

The configuration settings can be found at Computer Configuration - Administrative
Templates - Remote Desktop Services — Printer Redirection.

For User Configuration, it will be have the same path - Administrative Templates -
Remote Desktop Services — Printer Redirection.

Fle Action View Help
e 2mz B8m Y

1 Presentation Settings ~f
4 | Remote Desktop Services
2 RD Licensing
» . Remocte Desitop Connection Chent
4 | Remote Desitop Session Host

17} Do not set default chent printer to be default prnter
i) Do not allow client printer redirection

/] Use Remote Desktop Easy Print printer driver fiest
&} Specdy RD Session Host server fallback panter drvef
i7] Redirect only the default client printer

=) Connections

In administration, another important aspect is to set the priority for the printer, so the
users have the same printer installer and can print as per their priorities. In this, the users
printing with higher priorities overpass the printing will lower priorities.

To do so, you need to add different logical printers and then add then as per the users or
departments that have different priorities.

To do this, firstly let us add a printer to the print server by following the steps given below.
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Step 1: Click on Server Manager > Tools > Print Management - then on the left panel
click Print Servers - then right click on Printers and > Add Printer.

P
Rl

File Action View Help

e 2@ .= BE

@ Print Management Printer Name Queue Status Jobs In ...
4 7| Custom Filters = Fax (redirected 2) Ready 0
b % All Printers (2) = Microsoft XPS Document Writer  Ready 0

b 7 All Drivers (5)
b 7| Printers Not Ready
b 7 Printers With Jobs
4 3 Print Servers
4 i mcndesktop11 (local)
b i Drivers

Show Extended View

View »

Refresh
Export List...

Help

Step 2: Next, follow the wizard to add the network printer like you do for a normal
workstation and at the end this printer will be shown in the Printer Management.

File Action View Help
% zm X 8

[ Pront Management Prirter Name Queue Status Jobs In ... Se | Actions
¢ % Commiitr v Ty T ;.
4 3 Priot Servers = Mcrosoft XPS Dacument Witer  Ready m

4 § mendesktopl Gocall || b (redwected ) Ready o m
b @) Drvers
b o Forms
p § Ports
= Printeny
¥ w Deployed Prnters
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Step 3: Now that we have installed the printer, we can set the priority on this printer -

Right click on the printer > Advanced - put a number at Priority from 1-99 > OK.

[ — =

| General | Sharing | Ports || Advanced || Color Management | Securty | Device Settings | About |

@) Always available

Availaple from 12:00 AM = To 12:00 AM

Direver v New Driver..,

@ Spool print documents so program finishes printing faster
Start printing after last page is spocled
@) Start printing immediately

Print directly to the printer

| Hold mismatched documents
/| Print spooled documents first
Keep printed documents

/| Enable advanced printing features

Printing Defauits... |  Print Processor... | Separator Page...

= 1 -
[[ OK ]Ic«u]; Zooly

Help
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28. Windows Server 2012 - Configure Print Drivers

If we want to add other additional drivers, so that our clients find them easier to install a
printer on their own. We must follow the steps given below

Step 1: Go to, Server Manager - Tools - Print Manager - Action - Add Driver...

| |
f@r | |Muwugeldven. ver Name Envionment  Driver Version Driver Isolation  Provider
4 ‘l# Refresh {Canon iR-ADV CS045/C5051 Cl...  Windows x84 6.2.9200.16430 None Canon
¥ Export List... HP Laserlet 8150 PS Class Oriver  Windows x84  £.2.9200.16430 None HP
b Microsoft enhanced Point and ... Windows x84 6.2.9200.16334 None Microsoft
bL_,Hd? . Microsoft enhanced Point and .. Windows NTxB6 6.2.9200.16334 None Microsoft
b o Printers WithJobs || ') pticrosoft XPS Document Write.. Windowsx64  6.2.9200.16384 None Microsoft
4 § Print Servers
4 3 IT-531 {local)
[ o Drivers |
D “_ orms
b § Ports
= Printers
b 1mm Deployed Printers

Step 2: Check both boxes > Next.

Processor Selection
Each processor uses its own set of printer drivers.

Select the processor of all computers that will be using this driver:

Processor
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Step 3: Choose the drivers Path to be installed and then > Next.

Printer Installation
Select the manufacturer and model of your pnnter

Choose your printer from the list. Click Windows Update to see more models.

J

To install the driver from an installation CD, click Have Disk.

Windows Server 2012

Manufacturer ~ | § Printers '_gi
Microsoft 5% Microsoft OpenXPS Class Driver [0
e - . (=
\
NRG aMicrosoft PS Class Driver ' |
OKI ol Microsoft XPS Class Driver |
RICOH ¥ | | L Microsoft XPS Document Writer vd bl
;] This driveris digitally signed. | WindowsUpdate | | HaveDisk.. |
Tell me why driver signing is important
=S ]
Step 4: Click the Finish button.
- Add Printer Driver Wizard =]
Completing the Add Printer Driver

Wizard
You have successfully completed the Add Printer Driver
Wizard.
You are about to add the following drivers:

HP Universal Printing PCL 6, x64, Type 3 - User Mode
HP Universal Printing PCL 6, x86, Type 3 - User Mode

To close this wizard, click Finish,

%)
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29. Windows Server 2012 — Network Services

Windows has many network services too and you might already be knowing that it can
become a router or a VPN Server too. Let us see how to use the Windows server 2012 as
a router by installing the Remote Access role to it.

PS: Server should have 2 network cards — One inside the LAN and the other facing the
internet.

To add the Remote Access role, we should follow the steps given below.

Step 1: Go to, Server Manager > Manage - Add Roles and Features - Next - Check
Role-based or feature-based installation > Check Select a server from the server
pool > Next.

Once all of it is done, then at the list of the roles find Remote Access and check it > A
pop-up window will open.

DESTINATION SERVER
Select server roles —
Before You Begin Select one or more roles to install on the selected server,
Ingtaliation Type Roles Description

Server Selection A Remote Access provides Seamless

I | Do oo o

(] Application Server Managed expenience based on
Features (] DHCP Server DirectAccess. RAS provides

= traditional VPN services including

L] DNS Server site-to-site ({branch-office or cloud)

] Fax Server connectivity. Routing provides

¢ File And Storaae Services (Installed traditional routing capabilities

A Hvper-V lnstalled including NAT, and other

4 ptitnlAe connectivity options.

] Network Policy and Access Services

[] Volume Activation Services

B| Web Server (IIS) (Installed

[C] Windows Deployment Services
(7] Windows Server Update Services

<1
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Windows Server 2012

Step 2: Click "Add Features”-> Next

Add features that are required for Remote Access?

The following tools are required to manage this feature, but do not
have to be installed on the same server.

4 Remote Server Administration Tools
4 Role Administration Tools
4 Remote Access Management Tools
[Tools] Remote Access GUI and Command-Line Tools
[Tools] Remote Access module for Windows PowerShel

< "

Include management tools (if applicable)

=

Step 3: Click Next.

L ] )

DESTINATION SERvER
Remote Access EEE——
Before You Begin Remote Access combines DirectAccess and RRAS VPN into a single management console.
instafation Type 7
Server Selection Deploy DirectAccess to allow ged & 1-joined computers to connect to the intemet corporate

network as DirectAccess clients. Connectivity is seamiess and transparent, and is avadable any tme
Server f0kes chent computers are located on the Internet. DirectAccess administrators can remotely manage chents,
Featuses ensunng that mobile computers are kept up-to-date with secunty updates and corporate compliance
| Remote pccess |
Role Services Depioy VPN to aflow client computers runming operating systems not supported by DirectAccess, or
conlmabion configured in a workgroup, 10 remotely access corporate networks over 3 VPN connection.
~ e

Configure RRAS routing features using the Routing and Remote Access console.

Tl [
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Step 4: Check on the DirectAccess and VPN(RAS) and Routing check boxes.

: OESTINATON SEAVIR
Select role services
Before You Begn Select the role services 10 mstall for Remote Access
nitaiaton Type Role services Description
Server Selecten Routing provides support for NAT
Server Roies 3 UININS Routers, LAN Routers runming U9
v - and multcast capable routers (IGMP
o Pron)

Ramote Access

Corfematon

Step 5: Click Install and wait for it to be installed completely.

DESTINATION SERVER
_—

Confirm installation selections

Before You Begin To install the following roles, role services, or features on selected server, click install.

installation Type [] Restart the destination server automatically if required
Server Selection Optional features (such as administration tools) might be displayed on this page because they have
been selected automatically. If you do not want to install these optional features, click Previous to clear
Sever RO their check boxes
Features
Remote Access Remote Access
S DirectiAccess and VPN (RAS)
Rote Services
[ commaon [
Remote Server Administration Tools
Role Administration Tools
Remote Access Management Tools

Remote Access GUI and Command-Line Tools
Remote Access module for Windows PowerShell

Export configuration settings
Specify an altemate source path
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After the installation is done, let us now see the setup of the router. For this, we need to
follow the steps given below.

Step 1: Go to, Server Manager - Tools - Routing and Remote Access.

He Adis Ve Heép

LG
A iiosiion
ﬂSe.UQau

) [ — et Welcome to Routing and Remote Access

Ruudng and fanzte Access provides secure remots acoess 10 prvate netatris.
Use Routing and remats accass b confiqure the folomng:

* A geawre connacen betwesh tad prvane settris.

o A Virtaal Private Netwerk (VN) geteway,

¢ A Db remote access server,

+ Hataek address trangiabon (NAT).

o LAN routeg

o A basr Fremal,

To 2¢d o Rovhng ané Remcte Access server, on the Acdon mens, dick Add Server,
For mane informadon about seting ug fouting asd Remote Access server, deployment sossancs, and trobleshacting, ses Salp.

Step 2: Right click > and then again click on Configure and Enable Routing and
Remote Access as shown in the following screenshot.

File Action View Help
@ o
= Routing and Remote Access Routing and Remote Access

@ Server Status
b e ~EMOte ACCESS

— onfigure and Enable Routing and Remote Acc

Disable Routing and Remote Access

5 secure remote access to private networks
anfigure the following:

All Tasks » Jrivate networks.
Delete :teway.

Refresh

Properties :

Help |

To add a Routing and Remote Access server, on the Action menu, click Add Sen
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Windows Server 2012

Step 3: Select the Network address translation (NAT) option > Next.

Configuration
You can enable any of the following combinations of services, or you can
customize this server.

" Remote access (dial-up or VPN)

Allow intemal clients to connect to the Intemet using one public |P address.

™ Virtual private networs (VPN) access and NAT

Allow remote clients to connect to this server through the Intemet and local clients to
connect to the Intemet using a single public IP address.

{™ Secure connection between two private networks
Connect this network to a remote network, such as a branch office.

™ Custom corfiguration
Select any combination of the features available in Routing and Remote Access.

s ] e

Step 4: Now choose your Ethernet card that will be facing your internet site as shown in

the following image and then > Next.

NAT intemet Connection
You can selact an exsting interface or create 3 new damand-dial nteface for
client computers to connect to the intemat.

(¢ Use this publc inteface to connect to the Intemet:
Network Intedaces
Name Description |_IP Address
Microsoft Hyper-V Net 152 168.1.20
Microsoft Hyper-V Net.. 10011

demand-dial interface to the Intemet

al interface is activated when a client uses the intemet. Select this
server connects with a modem or by using the Point40-Point Protocol
ot The Demand-Dial Interface Wizard will start at the end of this wizard.

Ethernet card facing internet or axternal

network
ECN T .

' tutorialspoint

EIMPLYEAEYLEARRMINEG

172



Windows Server 2012

Step 5: Choose I will set up name and address services later as we have already set
up the DHCP and DNS and then - Next.

Name and Address Translation Services
You can enable basic name and address services.

Windows didnt detect name and address services (DNS and DHCP) on this network.
How do you want to obtain these services?

(" Enable basic name and address services
RouipdeemoteAcousaafmsaddmauanwcdyaﬂfawadsnane

¢ | will set up name and address services later

Choose this option if you have set up the Active Directory on your network, or if you
have DHCP or DNS servers in your network.

Step 6: Click the Finish button.

daton Vew Hep
e 2EE0as B
E fouting and Remote Access | Reiog]
4 mw g = Type 1P Address Incoming bytes  Outgoingbytes Static Ftess
"X Mo eetocs [ T T n P
3 Remote Access Loggin LN Dedicated 10411 12625 61610 Dcicd
4 i P Sintemet Dedicated 162168120 151,037,781 5,236,300 Disabled
Im‘l || & Internal Internal Mot avadable ~ m
= IGMP
B T
4 i P
B Genenal
B Static Routes
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Now let us see how to make the VPN Setup to allow the employees to connect from home.

To do this, we must follow the steps given below.

Step 1: Go to, Server Manager - Tools - Routing and Remote Access - Right click >
and then again click on Configure and Enable Routing and Remote Access > Custom

Configuration and then > Next.

You can enable any of the following combinations of services, or you can
customize this sarver

" Remote access {dialup or VPN)
Alow remote clerts to connect to this server through etther a dialup connection or a
secure virtual private network (VPN) intemet connection

" Network address transiation (NAT)
Alow intemal chents to connect 1o the Intemet using one public 1P address.

(" Vintual private network (VPN) access and NAT

Miow remots ciients to connect to this server through the Intemet and local clients to
connect to the Intemet using a single publc [P address.

(" Secure connection between two private networks

“
Selact any combination of the features avaiable in Routing and Remote Access.

Step 2: VPN Access and then > Next.

Custom Corfiguration
Vihen this wizard closes, you can corfigure the selected services in the Routing
and Remote Access console.

[~ Demand dial connections ( used for branch office routing )
[~ NAT

™ LAN routing
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Step 3: Click the Finish button.

Routing and Remote Access Server Setup Wizard

Completing the Routing and Remote Access
Server Setup Wizard

You have successfully completed the Routing and Remote
Access Server Setup wizard.

Routing and Remote Access

Start the service

The Routing and Remote Access service is ready to use.

fvices

To close this wizard, click Finish.

T e [
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30. Windows Server 2012 - Backup Management

In this chapter, we will install and configure Backup which does not differ too much from
the previous versions.

To Install the backup feature, we should follow the steps given below.

Step 1: Go to Server Manager > Manage - Add Roles and Features - Next - Check the
Role-based or feature-based installation box > then check on the Select a server
from the server pool box and then click Next.

Once all this is done, check the Windows Backup Server box and then click on Next as
shown in the following screenshot.

DESTINATION SERVER
[E—=——=]

Select features

I A The destination server has a pending restart, We recommend that you restart the destination server before either instaling o.. X I
Select one or more features to install on the selected server.

Before You Begin

nstaliation Type
Server Selection
Server Roles

Confirmation

] WINS Server =
7] Wireless LAN Service .
v WoWod Support (Instalied
(7] XPS Viewer <
<| w )
==
tutorialspoint

Features

>

B Windows PowerShe nitalle

] Windows Process Activation Service

Windows Server Migration Tools
] Windows Standards-Based Storage Management
] Windows System Resource Manager [Deprecated]
] Windows TIFF IFilter
[T] WinRM 1S Extension

Description

Windows Server Backup allows you
to back up and recover your
operating system, applications and
data. You can schedule backups, and
protect the entire server or specific
volumes.

Install
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Step 2: Click Install and then wait for the process to Finish.

DESTINATION SERVER
EEmm——)

Confirm installation selections

I A The destination server has a pending restart. We recommend that you restart the destination server before either installingo.. X ]
To install the following roles, role services, or festures on selected server, click Install

Sefore You Begin

Installation Type ] Restart the destination server automatically if required

Server Selection Optional features (such as administration tools) might be displayed on this page because they have

o Role been selected automatically. if you do not want to install these optional features, click Previous to clear
seehindlice their check boxes.

Features

I

Export configuration settings
Specify an alternate source path
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Now let us go and Configure the Backup Feature it, for which we should follow the steps
given below.

Step 1: Go to Server Manager - Tools > Windows Server Backup.

Component Services
Computer Management

Connection Manager Administration Kit
Defragment and Optimize Drives

Event Viewer

Group Policy Management

iSCSI Initiator

Local Securnity Policy

Microsoft Azure Services

Network Policy Server

ODEC Data Sources (32-bit)

ODEC Data Sources (64-bit)
Performance Monitor

ViCe:! Remote Access Management

Resource Monitor

Routing and Remote Access

Security Configuration Wizard

Services

System Configuration

System Information

# Local Server - TaskScheduler B
| Windows Firewall with Advanced Secmty_

Manageability - M Windows Memory Diagnostic

Events 3 Windows PowerShell
. ¢ e Windows PowerShell (x86)

ervices - |
' Windows PowerShell ISE
Performance P| Windows PowerShel! ISE (x86)
BPA results g Windows Server Backup
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Step 2: Click on Backup Schedule... in the left side panel or click on Action at the top
of the screen as shown in the following screenshot.

% 2w B
Wiecows Serer Backep 1 ; -
mstenband ocal Rackup ‘
& You can perform 3 single bacaup or schedue aregudar backup using this appication.

& Ascheduled Sxchup b et bees conigured for ths computer (os the Bactup Schechde Wizt 1o 542 43 3 regaler actmerated Sachup % pratect yur dits

Messages [Activity from kst week, double dick on e meisage to see detali) Configurs Peciammance Settng:..
Tive . Message Descrpton Vo '
B ry
: 4

States

Lt Badop Mext Backip 8 Badogn

S ) Soccetd Datur Netschedded Totatbackags: 1capes
Tme  WIRNSUM Tee: -

lwotcepy: 1NERITM
- s . T Oidepceons  1TAGNE CRIPM

Step 3: Click Next.

&;ﬂ Getting Started

Getting Started You can use this wizard to configure backups to run on a regular schedule,
fi i
AR AT To create a backup schedule, you should first decide:
Specify Backup Time - What to back up (Full Server, System State, selected files, folders or volumes)
: A - When and how often to back up your server
Specify Destination Type - Where to store the backups
Confirmation

To continue, click Next.
Summary

< Previous Finish | | Cancel |
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Step 4: If you want to backup a file or a folder, you can click on custom file, but in this

case I want to do a full backup of the server. So, we should click on the first option Full
server (recommended) and then click Next.

Getting Started

® Full server (recommended)
I want to back up all my server data, applications and system state,
Backup size: 11.97 GB

O Custom
I want to choose custom volumes, files for backup.

Select Backup Configurat..,

Specify Backup Time

Specify Destination Type

Confirmation

Summary

< Previous ” Next > I | Finish | Cancel
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Step 5: We should do backup once in a day, so we will choose the first option and the
appropriate time, which generally is recommended at night > Next.

;!i{ﬁ: Specify Backup Time

Getting Started Horw often and whe n do you want o run backups?
Select Backup Configurat_. ) Once 2 day

& Backup Time i

Specify Destination Type (2) More than once 3 day
Chick an available time @nd then dick Add to add itto the backup schedule,
Aailable tave: Scheduled time:

Confirmation

umma
" 12:00.50
12:30.00
1:00 A2
1:30 b
2:00 Ak
2:30 Ap
3:00 Ab
3:30 Ab
4:00 &
4:30 Ab bl e

200 PR (]

INES

[ <prevows || mer> || fio | Concnl |

Step 6: We should not click on the Back Up to a shared network folder option because
the backup should be saved somewhere out of the server that is being backed up and then
click on Next.

Clj,‘f" Specify Destination Type

Getting Started Where do you want to store the backups?
Selact Backup Configurat.. - Back up to 3 hard disk that is dedicated for backups (recommended)

Choose this option for the safest wary to store backups, The haed disk that you use
Spacly Buckip Tine ‘wil be formatted and then dedicated to only stare bactups.

Specdy De

bration Type

s Sl ) Back up to 3 volume
Sty s Choose this option if you cannot dedicate an entee disk for backups, Note that the
Confirmaton performance of the volume may be reduced by up to 200 percent while it is used
e to store backups, We recommend that you do not store other server data on the
iidsighe' same volume,

(®) Back up to 3 thared network folder
Choose this option if you do not want to store backups locally on the server. Note
thst you will only have one backup 82 s time because when you treste 3 new
backup it overarites the previous backup,

[oows | > | o [ ]
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Step 7: At the location, put the shared folder path and then > Next.

o Backup Schedule Wizard -

e s
fg"I_, Specify Remote Shared Folder

Getting Started Location:

Select Backup Configurat... I, = c up 5|

specify Backup Time Exarnple: VWhyFileServer\SharedFolderMarme

Specify Destination Type This wizard creates a folder based on the name of the server being backed up, for

exarmple MyServer-BackupFiles,

specify Remote Shared F.,

Confirmation Arcess Control

SUrMmary

® Inherit

This option makes the backup accessible to everybody who has access to the
specified remote shared folder,

@ The backed up data cannot be securely protected for this destination,
ore Infarmation

< Prewvious Cancel
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Step 8: It will pop-up a credentials table asking you for the username and password of
the shared folder which you should put here and then click > OK.

Backup Schedule Wizard

Specify Remote Shared Folder

Gett.ing Started Location:
Select Backup Configurat...
Specify Backup Time
Specify Destination Type Register Backup Schedule
—— - Please provide the user name and password to use for scheduling backup.
Specify Remote Shared F... The user account should have write access to the network share and
Confirmation should be an administrator or a backup operator on the local machine.
Summary
H I Mser name
[ Password
< Previous II Next > Finish Cancel
tutorialspoint

EIMPLYEAEYLEARRMINEG

Lx |

183



Windows Server 2012

Step 9: Click the Finish button.

@ Confirmation

Getting Started You are about to create the following backup schedule,
Select Backup Configurat... Backup times: .00 PM

Specify Backup Time Files excluded: None

Specify Destination Type Advanced option: VSS Full Backup

Backup destinations:  \\[Nb>ckups
Backup items

Specify Remote Shared F..,

Name
&JBare metal recavery
& Local disk (C:)
@ ystem Reserved
9 System state

184

' tutorialspoint

EIMPLYEAEYLEARRMINEG



Windows Server 2012

Step 10: Now you will get a window showing the status if the backup was created
successfully or not, which can be seen in the following screenshot.

Backup Schedule Wizard

A
T A
r_\_':" I Summary

(Fetting Started Status:  You have successfully created the backup schedule,

select Backup Configurat.., Your first scheduled backup will happen at 6/20/2076 2:00 P,

Specify Backup Tirme
Specify Destination Type
Specify Rernote Shared F..,

Confirmation

SU T Eny

< Previous

Close

tutorialspoint

EIMPLYEAEYLEARMNINEG

&

185



